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CHAPTER 1

Introduction

The Ecosystem Functions Model (HEC-EFM) is a planning tool that aids in analyzing ecosystem
response to changes in flow regime. The Hydrologic Engineering Center (HEC) of the U.S.
Army Corps of Engineers is developing HEC-EFM to enable project teams to visualize existing
ecologic conditions, highlight promising restoration sites, and assess and rank alternatives
according to the relative change in ecosystem aspects.

Central to HEC-EFM analyses are "functional relationships". These relationships link
characteristics of hydrologic and hydraulic time series (flow and stage) to elements of the
ecosystem through combination of four basic criteria: 1) season, 2) duration, 3) rate of change,
and 4) percent exceedance.

After relationships are developed, HEC-EFM performs statistical computations to analyze flow
and stage time series for the specified criteria and produces a single flow value for each
relationship. This process can then be repeated for alternative flow regimes to compare different
project scenarios and indicate directions of changes to ecosystem health (Figure 1).

In addition to the statistical computations, HEC-EFM analyses typically involve hydraulic
modeling (performed outside of HEC-EFM), which can translate statistical results to water
surface profiles and spatial layers of water depth, velocity, and inundation areas. Geographic
Information Systems (GIS) can then be used to display these generated layers as well as other
relevant spatial data (i.e., soils, vegetation, and land-use maps).

Data requirements of HEC-EFM are related to the level of detail desired by the modeler. If only
statistical results are desired, then required data consists of the flow regimes to be analyzed and
the eco-hydro relationships. If the user intends to visualize statistical results spatially, data (and
software) requirements increase significantly to include flow and stage time series, eco-hydro
relationships, digital topography, a geo-referenced hydraulic model, and any other spatial data
relevant to the ecosystem investigations.

This quick start guide provides an overview of the software (Chapter 2), a description of the
numerical processes performed by the software (Chapter 3), examples that demonstrate its use
(Chapter 4), information about application at different scales (Chapter 5), details about
multivariate analyses (Chapter 6), and language support (Chapter 7). Text has been formatted to
help readers keep track of the different types of information presented. [ltalics are used to
identify software features that are available through the user interfaces of HEC-EFM.
Underlines are used to identify model input data, which includes the names of flow regimes and
relationships used in the demonstration project. Bold is used to highlight key information for
individual sections of text.
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Figure 1. The process of applying HEC-EFM involves statistical analyses, river hydraulic
modeling, and spatial analyses. Key inputs are hydrologic time series and ecological information
such as the life history requirements of species of interest (e.g., seasons, durations, and frequencies).
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CHAPTER 2

User Interface

The main interface of HEC-EFM consists of a title bar, a series of menus, four tabs (Properties,
Relationships, Tables, and Combo Relationships), a message bar, and a Recalculate button
(Figure 2). Most features are located on the tabs. The rest of this section provides more detail
for those tabs.

Title bar - Contains title of current project.
File Menu - Create, open, and save projects, access project reports and other output, and manage report formats.
Edit Menu - Manage flow regimes, relationships, combo relationships., geographical queries, and language resources.
Plot Menu - Activate and manage connections with HEC-EFM Plotter, a utility for viewing computational output.

Help Menu - Contains demo project, documentation, terms and conditions for use, and information about the software.

File Edit Plot Help

Model information
Title: IRoling River study I
Author: IRolng River study team I
Location: I I
Description: Ecosystem Functions Mode! demonstration project.

EFM model pathname:C:\User\My Documents\HEC-EFM\Rolling River\Rolling River.efm

Flow regimes (paired time series of flow and stage)

Ref | Active | Identifier | Fiename | PartA PartB PartF | Startng |  Ending
Natural Rolling River Data.i ROLLING RIVEI AT EFM XS NATURAL 01/01/1974 09/30/2023
O| O |caged Rolling River Data.i ROLLING RIVEI ATEFMXS | GAGED 01/01/1974 = 09/30/2023

Properties Relationships Tables Combo Relationships
|O|:)emd C:\User\My Docunent&V-EC-E’NRohg River\Rolling River.efm Recalculate Ik

Recalculate button - Initiates model computations. J

— Combo Relationships Tab - Allows grouping of relationships to represent a single ecosystem dynamic.

— Tables Tab - Presents statistical results, project reports, and other output for flow regimes and relationships.

— Relationships Tab - Used to define statistical and geographical links between hydrology and ecology.

'— Properties Tab - Used to define information about the project, including the flow regimes to be analyzed.

— Message bar - Reports current status of the project.

Figure 2. Key components of the main interface of HEC-EFM.
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2.1 Properties

The Properties Tab contains information relevant to the model as a whole and is divided into two
frames: Model Information and Flow Regimes (Figure 3).

File Edit Plot Help

Model information
Title: |Rohg River study |
Author: IRohg River study team I
Location: I I
Description: Ecosystem Functions Model demonstration project. A

EFM model pathname:C:\User\My Documents\HEC-EFM\Rolling River\Rolling River.efm

Flow regimes (paired time series of flow and stage)

Ref | Actve | Identifier |  Filename | PartA PartB PartF | Starng |  Ending
Natural Rolling River Data.i ROLLING RIVEI ATEFM XS |NATURAL 01/01/1974 = 09/30/2023
O| O |Gaged Rolling River Data.i ROLLING RIVEI|ATEFMXS  |GAGED 01/01/1974 = 09/30/2023

Properties Relationships Tables Combo Relationships
ch)ened C:\User\My Documents\HEC-EFM\Rolling River\Rolling River.efm Recalculate

Figure 3. The Properties Tab of HEC-EFM is used to document information about the project and
to define the flow regimes to be analyzed. Two flow regimes (Natural and Gaged) are shown.

Model Information — Model information documents metadata (7itle, Author, Location, and
Description) about the project.

Flow Regimes — An HEC-EFM "flow regime" is defined as two concurrent daily time series that
reflect conditions at a single location in the study area. Typically, a flow regime is composed of
time series of daily mean flow and daily mean stage data. HEC-EFM accepts input data from
several text formats (i.e., comma, space, and tab delimited), from HEC Data Storage System

2-2
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(HEC-DSS), which is the database used by HEC models for storage of time series and other data,
and from the Hierarchical Data Format (HDF), which is a database used by a few HEC models
for storing two dimensional outputs. The start and end dates for flow regimes are controlled by
the user, which can be a handy feature when analyzing only part of the period of record.

2.2 Relationships

HEC-EFM "relationships" are statistical representations of links between hydrology and ecology.
Relationships are typically developed by teams of scientists and engineers using a combination
of expert knowledge and scientific literature. Relationships are defined on the Relationships
Tab, which is broken up into four frames: Statistical queries, Geographical queries, Other
queries (nonstandard), and Options (Figure 4).

File Edit Plot Help
Options

Relationship name: | S UL [[] write computation arrays  [] Active

Description: Little mi in shallo ated floodplain areas o .
bet\:re";nm ;ma?ymaﬁg May. gg?nge sustgned high [¥] Hypothesis tracking - increased flow will
flows for approximately 21-to 28-days before hatching. Good @+ O- O/ Cuve | eco-health
spawning conditions need to occur, on average, at least !
once every four years. [A] Confidence tracking: 4 3% 3%3% 3%

'Index | A B (JC D JE
Statistical queries Geographical queres Other queries (nonstandard)
[ Season Depth Shallow habiat 0- | [ | | [ Beverse lodkus: @ Fiow
From: |02/01 (m/d) to 34t Value cfs
To: 05/31 (m/d) Vegetation Requines: — alues per Flow Regime
[~ Duration of days of aquatic plants Range to cfs
For each duration, compute: Ranges per [RFIOWREamE
Minimums N
From computed values, select the:
Maximum v

and cfs

[J Rate of change: @) Stage O Flow

[:] feet per days [[] Ecovalue summation:

Time series specifications = £l

% % exceedance (4.00-yr)

(® Flow frequency O Flow duration

D‘:] toD Water year range Dutput total fo

Report parts:
Dl:l Individual water year S
[[] Relationship-defined water year

N

Properties Relationships Tables Combo Relationships
Opened C:\User\My Documents \HEC-EFMRolling River \Rolling River.efm Recalculate | .

Figure 4. Using the Relationships Tab of HEC-EFM, modelers define individual relationships as
combinations of statistical and geographical criteria.
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Statistical Queries — Fields within Statistical queries allow users to input criteria (in terms of
Season, Duration, Rate of change, and Percent exceedance) that define the statistical analysis to
be performed for each relationship. All criteria do not need to be filled in for each relationship —
only those that are important for the relationship. Time series specifications can be entered as
Flow frequency (percent of years) or Flow duration (percent of time). Statistical queries also
offer controls for managing the flow and stage data to be used for the statistical computations.
Options are given for Water year range, Individual water year, or Relationship-defined water
year, which allows a relationship to be based on the statistical results of a separate relationship.

Geographical Queries — Geographical queries allow users to specify criteria that define
relationships from a spatial perspective. Geographical queries are created by the user through
the Manage Tags for Geographical Queries interface (Figure 5), which is accessed by selecting
the "Edit — Manage Geo Queries..." menu option. Users create tags and specify the tags that are
important for each relationship. This action creates a text field in the HEC-EFM interface for
recording how the tagged data sets need to be queried in GIS. A tag is a simple name that
identifies sets of spatial data layers important to an HEC-EFM project.

Project tags

Tags are simple names that identify sets of spatial data layers important to an EFM
project. Project tags are available for use in each relationship. The following tags have
been created for this project:

Depth, Vegetation, Land Use Addtag...
Rename tag...
Delete tag...
Activate tags for each relationship
Relationshi Selected Tags

: ) : 2 ) i = Select tags...
Little minnow spawning habitat Depth, Vegetation
Big bass winter habitat
Benthic macroinvertebrate biodiversity
Wetland health

Riparian tree recruitment
Riparian tree inundation Depth
Wetland health reverse lookup

Figure 5. The Manage Tags for Geographical Queries interface in HEC-EFM is
used for editing and creating tags, which are labels for sets of spatial data important
to an HEC-EFM project.
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Other Queries (nonstandard) — Statistical results for a standard HEC-EFM relationship is a
pair of flow and stage data that meet the statistical criteria specified for that relationship.
Currently, the only nonstandard queries available are Reverse lookup and Ecovalue summation.
Reverse lookups do not compute a flow and stage, instead the user specifies a flow and HEC-
EFM computes the percent of years or percent of time that flow is equaled or exceeded.
Ecovalue summations tally the ecovalues (see sections 3.6.1 and 3.6.3) provided by different
flow regimes. When the Ecovalue summation query is turned on for a relationship, summations
are computed in addition to all steps normally performed to assess that relationship. Ecovalue
summations can be done for standard or Reverse lookup relationships. The Hypothesis tracking
option must be selected to use ecovalue summations.

Options — Three options are available for each relationship: Write computation arrays,
Hypothesis tracking, and Confidence tracking. The Write computation arrays option prompts
HEC-EFM to export the statistical computations performed for that relationship. Hypothesis
tracking allows users to compare the direction of change of eco-health for different flow
regimes. The question that hypothesis tracking asks is: "Increased flow will do what to eco-
health?" for this relationship. Users have the option of saying that increased flow will help (+),
hurt (-), or have a non-linear response (via the Curve button) to eco-health. Confidence tracking
provides a way to track the relative certainty of HEC-EFM relationships. The default is one star.
This starting point implies that there is the same amount of scientific understanding for each of
the relationships. As confidence in a particular relationship grows, its number of stars can be
increased at the discretion of the study team, perhaps when the relationship is verified with field
data, backed with scientific literature, or approved by a group of scientists or agencies.

2.3 Tables

The Tables Tab presents statistical results for pairings of flow regimes and relationships. The
Tables Tab is also where users can view project reports, arrays files, and output files (Figure 6).
Tables can be printed or copied into other applications. After the Recalculate button is pressed,
the HEC-EFM interface will automatically go to the Tables Tab to display the new statistical
results.

24 Combo Relationships

Combo Relationships are used to detail how two or more individual relationships are grouped to
represent a single ecosystem dynamic. For example, in Figure 7, Riparian tree establishment is
defined as Riparian tree recruitment minus Riparian tree inundation.

2-5
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File Edit Plot Help

Evaluated on: 05/29/2020 14:45 A
Summary
Natural Gaged
Relationship Conf.  Stage, ft Flow, cfs Chg. Stage, ft Flow, cfs
Little minnow spawning habitat d 4,275.2 1,226 Pos 4,275.7 1,703
Big bass winter habitat i 4,274.1 525 Pos 4,274.3 609
Benthic macroinvertebrate biodiversity|* 4,279.4 6,620 Neg 4,277.2 3,190
Wetland health i 4,274.3 636/ Pos 4,274.5 771
Riparian tree recruitment - 4,274.9 1,017| Pos 4,275.1 1,129
Riparian tree inundation i 4,273.7 373| Neg 4,274.3 609
Index
Values
Index Gaged
A-All -4.7
B - Fish, 27.4

No reverse lookup flow frequency data sets were analyzed.

Reverse Look-ups - Flow Duration

Natural Gaged
Relationship Conf. | %X, oftime | Chg. | %X, of time

Wetland health reverse lookup i 34.1 Pos 67.1

v

Properties Relationships Tables Combo Relationships
Recalculate 5

Figure 6. The Tables Tab of HEC-EFM is used to display statistical results for 7
simulations (as in this figure), project reports, and computational output.

File Edit Plot Help

Combo Relationships
Combo relationship name: | Riparian tree establishment v|
Primary layer Action Connected layer(s)
Riparian tree recruitment v ldip v |Riparan tree inundation v|

Properties Relationships Tables Combo Relationships |
C:\User\My Documents\HEC-EFM\Rolling River\Rolling River.efm Recalculate +

Figure 7. The Combo Relationships Tab of HEC-EFM allows for grouping of separate relationships
to represent a single ecosystem dynamic.
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CHAPTER 3

HEC-EFM Math

While the HEC-EFM process can involve hydraulic modeling and GIS, statistical analyses of
links between hydrology and ecology are the foundation of HEC-EFM applications.

The math performed by HEC-EFM during these statistical analyses is actually very basic. The
challenge is in understanding how the parameters that define relationships (Season, Duration,
Rate of change, and Percent exceedance) are used by HEC-EFM to compute the flow and stage
that meet those criteria.

3.1 Season

Season is the most intuitive of the parameters. Ecosystem dynamics (e.g., fish spawning or seed
germination) typically occur in certain time periods of the year. Within HEC-EFM, season is
defined by start and end dates. During computations, a seasonal extract is taken from each water
year being investigated. All Duration and Rate of change queries are performed on these
seasonal extracts.

3.2 Duration

Duration is a versatile, but complicated query. Three settings are available: 1) number of days,
2) a selection of statistics to be computed for each duration in the season, and 3) a selection of
statistics to be computed using the time series of computed values produced in step two.

The number of days defines a duration interval (Figure 8). Duration calculations are performed
from the beginning of season to the end of season. So for the start date, HEC-EFM considers all
data values within the duration interval (per setting 1), computes a statistic (per setting 2),
records that value for the start date, and then advances a day and repeats the process until the end
of season is reached. This process produces a statistical time series of Minimums, Medians,
Maximums, User defined percentages, or Means (per setting 2) that has one value for each day of
the season.

The final step in the Duration query involves selecting a single seasonal value (per setting 3)
from the statistical time series. Options are provided for Minimum, Median, Maximum, User
defined percentage, and Mean. This process produces a time series of seasonal results that has
one value per season.

Figure 8 provides an example of this process using an 8 day duration interval, minimums, and
then maximum of the minimums.
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Figure 8. Sample use of the Duration query in HEC-EFM. Computations are shown for one water
year. Statistical queries (to right of graph) are shown as in the EFM interface in Figure 4.

3.3 Rate of Change

The Rate of change query was originally added to HEC-EFM to look at ecological concerns
connected to the recession limb of stage hydrographs. Its capabilities have since been expanded
to include Rising, Falling, and Absolute rates of change for both Stage and Flow.

For all combinations of those settings (Figure 9), the Rate of change uses two parameters: 1) the
threshold value for change and 2) the number of days. For each day beginning at the end of the
season and working backwards in time, the actual rate of change is computed by subtracting the
current flow or stage and the flow or stage that occurs at the end of the time interval defined by
the number of days (i.e., if number of days is set to 4, the actual rate of change equals the current
value minus the value 3 days into the future such that the total time interval being considered
spans 4 days). The actual rate of change is then compared to the threshold value. 1If actual does
not violate threshold, the rate of change is deemed acceptable, HEC-EFM moves backwards one
day, and the test is repeated. This process continues until the threshold is violated or the
beginning of season is reached.

If the threshold is violated, HEC-EFM selects the previous successful test (one day later than the
failed test) as the seasonal result, which represents the date and conditions where rates of change
became consistently acceptable for the rest of the season.

If the beginning of season is reached and passes the rate of change test, HEC-EFM selects that
date and its corresponding conditions as the seasonal result.
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Figure 9. Sample use of the Rate of change query in HEC-EFM. Computations are shown for one
water year. Statistical queries (to right of graph) are shown as in the EFM interface in Figure 4.

If the first test (at the end of season) fails, a zero value is recorded as the seasonal result, which
indicates that no dates passed the rate of change test for that season.

It is also important to note that when Rate of change is selected in the HEC-EFM interface, the
dropdown controls in the Duration query become gray and inoperable. This behavior is meant to
communicate that the two queries are largely incompatible. In fact, the only Duration setting
relevant to Rate of change is number of days. When duration is set to 1 day (as in Figure 9), the
Rate of change query tests the mean daily values obtained from the flow regimes in the seasonal
extract. When an integer of 2 or more is entered, HEC-EFM will compute a time series of mean
values for that duration of flow or stage, depending on the setting in Rate of change, and then
perform the rate of change tests for that computed series.

3.4 Time Series Specifications

Components in the Time series specifications section of HEC-EFM include Percent exceedance
and three controls for managing the period of record assessed for each relationship (Water year
range, Individual water year, and Relationship-defined water year).

The Percent exceedance query offers a choice of either Flow frequency or Flow duration. Flow
duration should not be confused with the Duration query described earlier in this chapter. In
fact, when Flow duration is selected in the HEC-EFM interface, the dropdown controls in the
Duration query become gray and inoperable. As with Rate of change, the only Duration setting
relevant to Flow duration is Number of days. When duration is set to 1 day, HEC-EFM

3-3



Chapter 3 - HEC-EFM Math HEC-EFM Quick Start Guide

generates a flow duration curve using mean daily values obtained from the flow regimes in the
seasonal extract and then interpolates to obtain the flow that corresponds to the user-defined
percentage. When an integer of 2 or more is entered, HEC-EFM computes a time series of mean
flow values for that duration, uses those values to generate a flow duration curve, and then
interpolates to obtain the flow that is equaled or exceeded for the user-defined percentage of
time. The resulting value would be the statistical result.

When Flow frequency is selected (Figure 10), HEC-EFM ranks the seasonal results (computed
via the Season, Duration, and Rate of change queries) and interpolates to obtain the flow (or
stage, if Rate of change is being used to investigate stage dynamics) that is equaled or exceeded
for the user-defined percentage of years. The resulting value would be the statistical result.

Statistical queries
i Season
From: (m/d)
2015 \:2016 l 2017 2013 2019 fo: (m/d)
¥ Duration of days
Seasonal Results For each duration, compute:

1 " Minimums |T || |
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1 0.05 2013 1,414 [0 Rate of change: ®Stage OFlow
2 0.10 2018 1,253 L. ™ per [¥]days
3 014 2008 1247 Statistical Result P v
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15 0.50 2008 480 100% 0%
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Figure 10. Sample use of the Time series specifications for a relationship with Season and Duration
queries (as in Figure 8). The statistical result is the flow meeting the parameters in those queries
that is equaled or exceeded in 25% of years (Flow frequency). Statistical queries (to right of graph)
are shown as in the EFM interface in Figure 4.

This ranking and interpolation process is required only when seasonal results are computed for
multiple years, whether for a whole flow regime as defined on the Properties tab (Figure 2) or via
the Water year range control (Figure 10).

Both the Individual water year and the Relationship-defined water year controls limit analyses to
a single water year. For the Individual water year, the user specifies which water year to assess.
For Relationship-defined water year, the user selects a separate relationship that is of interest,
and HEC-EFM determines which of its seasonal results (and corresponding historical water year)
most closely equals its statistical result. That historical water year is then used when assessing
the current relationship. In both cases, as there is only one seasonal result, it is also reported as
the statistical result.
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3.5 Reverse Lookups

Reverse lookup relationships follow the same numerical process described earlier in this chapter,
except the last step in determining the statistical result is reversed. That is, instead of specifying
a Percent exceedance and having the software compute the corresponding flow or stage (Figure
10), users specify the flow or stage of interest and the software computes the percentage of time
or of years that flow or stage is equaled or exceeded (Figure 11). Application of Season,
Duration, Rate of change, and Flow frequency or Flow duration settings are unchanged.

Users specify which flow regime data to analyze (flow or stage), the value or range of interest,
and whether to report “out of range” results with a numeric result. Value and range can be
applied to all flow regimes or set individually for each flow regime. The per flow regime options
are useful when flow regimes are location-based. For example, especially over large areas,
floodplains become inundated at different times and for different durations in accordance with
local conditions. A relationship that investigates how frequently floodplain activation occurs
could use the Reverse lookup — Values per flow regime setting to quantify floodplain dynamics
for different location-based flow regimes per the local conditions that trigger inundation.

When values and ranges do not intersect with ranked seasonal results (Figure 10, bottom left and
center), statistical results are “out of range” and reported as text messages. An option is offered
that allows results to be reported as 0 when above range and 100 when below. For example, if a
value of 600 was queried and all seasonal results were greater than 600, the statistical result
would be “below range” or equaled or exceeded “100%” if the handle option was selected.
Results are always computed for the percentage of time or years equaled or exceeded. For
ranges, HEC-EFM computes this equaled or exceeded condition for the Min and Max values,
subtracts Max from Min, and reports that difference as the percentage of time or years in range.
“Out of range” conditions occur when either the Min value or Max value do not intersect.

Reverse lookup: @) Flow () Stage <— Select which flow regime data to analyze,
flow or stage.

O Value 600 |cfs
O Values per Specify the value or range to analyze

<— (options: one value/range for all flow regimes
O Range 600 to cfs or different values/ranges for each flow regime).

(® Ranges per | Flow Regime
k Option to return a numeric result, 0 or 100

Handle out of range with O or 100 <— (in lieu of an “out of range” text message).

Show active only

Active Flow Regime Min value, cfs Max value, cfs
Natural 600 1000
Gaged 600 1000 Apply
W Natural - Location 2 1500 4000
Gaged - Location 2 1500 4000 Cancel

Figure 11. The Reverse lookup feature queries the percentage of years or time a value
is equaled or exceeded or the percentage of time or years conditions are in range.

3-5



Chapter 3 - HEC-EFM Math HEC-EFM Quick Start Guide

3.6 Other Math Features

In addition to seasonal and statistical results, HEC-EFM also computes relationship-based
ecovalues and dates of occurrence for each season within the period of record, as well as indices
that involve multiple relationships. Ecovalues are useful in assessing how successfully habitat is
provided. Dates of occurrence are useful in assessing the seasonality of habitat availability.
Indices are used to numerically combine several relationships to compute a single measure of
how a flow regime more broadly affects an ecosystem or ecosystem component.

3.6.1 Ecovalues and Ecovalue Shift

Ecovalues are measures of how well flow regimes meet the needs of relationships. Users specify
how seasonal and statistical results translate to ecovalues through the hypothesis tracking feature
available as part of each relationship. Ecovalues can either be set equal to the flow result (i.e.,
when the “+” hypothesis tracking setting is active), the negation of the flow result (i.e., when the
“-” setting is active), or interpolated based on the flow result and a table provided by the user
(i.e., when the “Curve” setting is active). This interpolation option allows users to score the
ecological success of different flow results. For example, a table could be applied that translates
flow results for a relationship to ecovalues on a scale from 0 to 10.

Ecovalues are computed for each season within the period of record. Seasonal ecovalues are
then used to compute a mean ecovalue for the whole flow regime (Figure 12). Mean ecovalues
are used as a variable in the computations of Indices, as described later in this chapter.
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Figure 12. Seasonal ecovalues shown as a time series (left) and in accordance with percent
exceedance (right). Ecovalues are measures of how successfully the criteria for a relationship are
met by a flow regime. Typically, increasingly positive ecovalues correspond to increasingly
beneficial habitat conditions.
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For flow regimes that are active and not the reference, seasonal ecovalue “shifts” are computed
as a percent change in ecovalue from the reference flow regime. Seasonal ecovalues and
seasonal ecovalue shifts are output as time series (one value per season per year) and as ranked
data (Figure 13). Both offer insights regarding how successfully habitat is provided and how that
success differs between flow regimes.
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Figure 13. Ecovalue shifts provide insight regarding changes in success (left) and changes in the
consistency of success (right) for a relationship. In HEC-EFM, “shifts” inherently compare an
active flow regime with the reference flow regime. Ecovalue shifts are computed as the percent
difference in ecovalue between active and reference flow regimes.

3.6.2 Dates and Date Shift

“Dates” are based on the day and month when the statistical parameters of a relationship are met
for each water year in the period of record. Numerically, a seasonal date value is set equal to the
number of days between 01 January and the day and month of its corresponding seasonal result

(e.g., a seasonal date value of 31 would correspond to a seasonal result occurring on 31 January;
Figure 14).

For flow regimes that are active and not the reference, seasonal date “shifts” are computed as the
change in date value from the reference flow regime. Seasonal dates and seasonal date shifts are
output as time series (one value per season per year) and as ranked data (Figure 15). Both offer
insights regarding how habitat availability fluctuates within the season of interest and how that
seasonality differs between flow regimes.
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Figure 14. Seasonal date values shown as a time series (left) and in accordance with percent
exceedance (right). Date values reflect when the criteria for a relationship were met within the
season defined for the relationship.
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Figure 15. Date shifts provide insight regarding changes in the timing (left) and changes in the
consistency of timing (right) of when criteria for a relationship were met. In HEC-EFM, “shifts”
inherently compare an active flow regime with the reference flow regime. Date shifts are the time
differences (numbers of days) between the seasonal date values of active and reference flow
regimes.
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3.6.3 Ecovalue Summations and Summations Shift

Ecovalue summations tally the accumulation of ecovalues provided by different flow regimes.
Ecovalue summations differ from the ecovalues described in section 3.6.1 because, whereas
ecovalues begin with the seasonal and statistical results of a relationship, summations begin with
a daily time series of ecovalues. This ecovalues time series is obtained by multiplying the last
computed time series for the relationship (one value for each day within season; in Figure 8, see
the time series of minimums shown in green) with the paired data set of flow versus ecovalue (or
percent exceedance versus ecovalue, for reverse lookups) from the Hypothesis tracking option.
This time series is the first of seven series that are associated with summations and can be output
to HEC-DSS per user settings.

Summations are tallied for the whole flow regime and independently for each season (Figure 16).
The progression of output follows: 1) daily ecovalue series, 2) tally for flow regime, 3) tally
status at the end of each season, 4) tally total for flow regime, 5) tally for each season, 6) tally
total for each season, and 7) a ranked set of seasonal totals from #6. By considering and tallying
the daily ecovalues provided, summations offer insight to services provided by whole seasons
and flow regimes.

4 Ecovalue series (1)
Tally for flow regime (2)
Tally status at end of season (3)
Q Tally total for flow regime (4)

? == Tally for season (5)
= [ Tally total for season (6)

— o Ranked seasonal totals (7)
S

b d 3
(V]

2 2 |
3 a
() .-

o 6 a®

[ |
7 o
. o
0
5 D
[m}
1 o |
-+ Period of Record Percent Exceedance

Figure 16. Ecovalue summations provide insight regarding ecovalue provided over whole seasons
and flow regimes. In HEC-EFM, “shifts” inherently compare an active flow regimes with the
reference flow regime. Summation shifts follow the sequence in figure, but are based on a time
series of daily difference in ecovalue (active minus reference flow regime) instead of the daily
ecovalue series (1).
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For flow regimes that are active and not the reference, summation “shifts” are computed as the
change in ecovalues provided from the reference flow regime. As for summations, summation
shifts are tallied for the whole flow regime and independently for each season. At the end of
each season, tally results are output as time series (one value per season per year). Seasonal tally
results are also output as ranked data. Both offer insights regarding how successfully ecovalues
are provided and how that success differs between flow regimes. Negative shifts are indicative
of ecovalue deficits relative to the reference flow regime; positive shifts show surpluses.

In version 5.0 of HEC-EFM, summation results can be output only to HEC-DSS.

3.6.4 Indices

A common result when analyzing multiple relationships is that for a certain flow regime, some
aspects of the ecosystem do well and others do poorly. Indices can help users look at the net
effect of different flow regimes. The confidence tracking and hypothesis tracking options must
be selected for a particular relationship to be included in an index. Indices are computed for flow
regimes that are active and not the reference. Each index is computed using a combination of
information about relationships and statistical results based on the following equation:

Index = z (Direction of Change,)*(Confidence,)*(% Change in Eco-value,)

i=1...n

Where:

i = counter from 1 to n

n = number of relationships in the index

Direction of Change; = 1, -1, or 0 for relationship,
1 indicates that relationship; experienced a positive change from the reference flow regime

-1 indicates that relationship; experienced a negative change from the reference flow regime

0 indicates that relationship,; experienced no change from the reference flow regime

Confidence; = an integer from 0 to 5 based on the confidence value for relationship,

% Change in Eco-value; = (Eco-value for relationship, — Eco-value for relationship, ;,..,...)

(Eco-value for relationship, . ,ec.)

Note: % change in Eco-value is equal to % change in Flow (using statistical results for flow)

when hypothesis tracking does not use the curve option.

3.7 Seasonal Flow Duration Analyses

The Flow Duration: Analyze seasons feature enables a hybrid flow duration - flow frequency
analysis for relationships that also use Time series specifications - Percent exceedance - Flow
duration and Reverse lookup options. Users are required to enter a Percent exceedance value
(Figure 17).

Figure 17. The Flow Duration: Analyze seasons feature is
available via the Relationships tab. It requires the user to specify
the % exceedance to compute and report.

Flow duration: Analyze seasons
Return % exceedance of I:I
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The compute process begins by applying Season and Duration criteria - as done for basic flow
duration reverse lookup relationships - though this is where the basic and hybrid approaches
diverge. The basic approach would then rank all daily values from all seasons in the period of
record and computes the percentage of time the reverse lookup value is equaled or exceeded.
The hybrid approach considers each season independently. Daily values within each season are
ranked and used to compute the percentage of time the reverse lookup value is equaled or
exceeded. This is repeated for each season in the period of record to compute a set of seasonal
results. Seasonal results are then ranked and the % exceedance value associated with the Flow
Duration: Analyze seasons feature is used to compute a corresponding percentage of time for the
whole period of record (Figure 18).

Season Seasonal extract (1)
== Ordered values (2)
Plotting positions (3)

Reverse [0 Seasonal results (4)
———————— --- - lookup o Ranked seasonal results (5)
value QO statistical result (6)

Season boundaries
== Reverse lookup

oo
6 DDD

L B AL ™ B =0
I:I O 4 >, oo a=®

% Exceedance
(Flow dur.)
0

Period of Record % Exceedance (Flow freq.)

Figure 18. Seasonal flow duration analyses use flow duration and flow frequency concepts to gain
insights about seasonal variability.

This nested approach supports consideration of season to season variability in flow duration
statistics. Similar functionality is provided via the Duration - User defined percentages control,
though the User defined percentages option can be applied only as part of Time series
specifications - Percent exceedance - Flow frequency relationships. These hybrid approaches
are among the most involved statistical analyses performed by HEC-EFM. Ordered flows and
corresponding plotting position values are output to help clarify the compute sequence. The
whole progression of output follows: 1) seasonal extract, 2) ordered values, 3) plotting positions,
4) seasonal results — per the Flow duration percent exceedance criterion, 5) a ranked set of
seasonal results from #4, and 6) the statistical result - per the flow frequency Percent exceedance
value specified by the user as part of the Flow Duration: Analyze seasons settings.

3.8 Handling Missing Data

As HEC-EFM considers ecosystem dynamics according to the percentage of years or percentage
of time that a flow or ecological event occurs, no conceptual reason compels an analysis to be
stopped due to missing data within a flow regime. Via the “Edit” menu, the software offers a
check option entitled “Handle Missing Data”, which instructs HEC-EFM to work around any
missing data, and a menu option called “Missing Data Identifiers...”, which opens an interface
where users can specify the numeric values to be treated as missing data (Figure 19). Blanks and
non-numbers are automatically identified as missing values.
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= g ———
Flow Regimes »

Relationships > Missing data identifiers

Combo Relationships > Identifiers are numeric values that will be treated as missing data during HEC-EFM
computations. Blank values and text are automatically treated as missing data.

Manage Geo Queries...

Plotting Position Type > 901, -902, -999 Add Identifier...
Unit System 4 :
Languages . Change Identffier...
Select Arrays Format » Delete Identffier...
Set Output Selections...

Apply Output Selections “
Parse Output
Handle Missing Data

Missing Data Identifiers... !}J

Recalculate Ctrl+R

Figure 19. The Missing Data ldentifiers interface is used to specify values to be treated as missing.

When the “Handle Missing Data” option is active and missing data are encountered, the
software simply omits the water year with missing data from the relationship’s calculations. The
number of valid years (i.e., years that have all required data) associated with rankings,
frequencies, and plotting positions are adjusted accordingly. As season is set for each
relationship, each flow regime is screened for missing data for each relationship.

HEC-EFM also generates a report that lists water years omitted due to missing data. To view the
report, use the "File — Data Summary" menu option (Figure 20).

File HEC-EFM data summary
New Ctrl+N . . , . - . i
This page describes the data used during analysis of each combination of Flow Regime, Relationship.
Open... Ctrl+O
S Ctrl+S Computations made: 07/08/2024 18:40, Rolling River.efm
Save As... Gaged, Little minnow spawning habitat
Period of Record: 01/01/1974 - 09/30/2023
Results Water year range: 1984 - 2003
Water years omitted due to missing data: None
SEREn Number of valid years: 20
Data Summary {
Gaged, Big bass winter habitat
Refresh Results Period of Record: 01/01/1974 - 09/30/2023
Water year range: 1974 - 2023
View Array File... Water years omitted due to missing data: None

Number of valid years: 50
Select Style Sheets  »
) ) Gaged, Benthic macroinvertebrate biodiversity
Print Preview Period of Record: 01/01/1974 - 09/30/2023
. Water year range: 1974 - 2023
Print Ctri+P Water years omitted due to missing data: 1974

) Number of valid years: 49
Recent Projects > ¥

Exit Gaged, Wetland health

Period of Record: 01/01/1974 - 09/30/2023
Water year range: 1974 - 2023

Water years omitted due to missing data: None
Number of valid years: 50

Figure 20. Excerpt from Data Summary report, which details periods of record, water year range,
missing data, and number of valid years for each pairing of flow regime and relationship analyzed.
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CHAPTER 4

Demonstration Project

This demonstration project will consider ecosystem relationships for a cross section of the
fictional Rolling River. The progression of tasks is to 1) build eco-hydro relationships, 2) set up
the model and compute statistical results, 3) simulate the statistical results with a hydraulic
model, and 4) use GIS to investigate the ecosystem responses spatially.

Two flow regimes will be analyzed. The "Gaged" flow regime has flows and stages that reflect
the current management plan for Rolling River, which is regulated by upstream dams. The
"Natural" flow regime has flows and stages that reflect how the river would behave without
reservoir regulation.

A completed demonstration project with flow regime data can be downloaded via the "Help —
Install Demonstration Project..." menu option.

4.1 Building Relationships

Each scenario described below presents information about an aspect of the ecosystem that the
Rolling River study team would like to investigate, the statistical and geographical queries used
to define each as an HEC-EFM relationship, and the logic used to craft those criteria.

4.1.1 Little minnow spawning habitat

The little minnow is a threatened species of fish indigenous only to the Rolling River basin.
Little minnow populations have declined (in magnitude and range) as dams and diversions
limited access to upstream river stretches and as floodplain areas, critical to little minnow
spawning, were transitioned to agricultural lands. Little minnow spawn in shallow (no deeper
than 3 ft), vegetated floodplain areas between February and May. Eggs require sustained
high flows for approximately 21 to 28 days before hatching. Little minnow reach sexual
maturity in their first or second year and have a lifespan of approximately 6 years. Scientists
suggest using the conditions within each spawning season that generate the largest extent of
effective spawning habitat as an indicator of success for each year’s spawn. Further, scientists
suggest that good spawning conditions do not need to occur every year — it would be sufficient if
there were good conditions in 25% of years, so that, on average, each little minnow would have
a chance to spawn in their lifespan.

HEC-EFM Relationship:
e Season: 2/1to 5/31
e Duration: 24 days, Minimums (sustained highs) and then Maximum (largest extent)
e Rate of change: Not applied
o Percent exceedance: 25% (4 yr) - Flow frequency
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e Hypothesis tracking: Increased flow will improve (+) floodplain spawning
o Geographical queries: Depth (0 to 3 ft) and vegetation (aquatic plants)

Comments. For the little minnow, successful spawning depends on having a sustained
inundation long enough for the eggs to incubate. These types of scenarios, where any
interruption will affect the ecosystem dynamic being modeled, typically use an initial statistical
setting of Minimums or Maximums for the Duration query. Minimums return a flow that will be
that high or higher for the length of the duration. Maximums return a flow that will be that low
or lower. This relationship also thinks in terms of percentage of years. The Percent exceedance
- Flow frequency option returns a flow and stage that are equaled or exceeded in the percent of
years specified by the user. The Percent exceedance - Flow duration option returns a flow and
stage that are equaled or exceeded in the percent of time specified by the user.

4.1.2 Big bass winter habitat

A study for big bass showed that fish mortality in a critical over-winter period, January through
May, was caused by a chronic lack of habitat. Mortalities began to occur when generally poor
conditions persisted for more than two weeks. Habitat shortages for these fish occur at low
flows. Scientists said that these chronic conditions are best represented by average low flows
and that, since these fish are in the river each winter, using a typical year (median conditions)
would be a good indicator. The study showed that suitable habitat is proportional to increasing
low flows (i.e., higher low flows create more habitat) until those low flows exceed 1,000 cfs.

HEC-EFM Relationship:
e Season: 1/1 to 5/31
e Duration: 14 days, Means (average) and then Minimum (low)
Rate of change: Not applied
Percent exceedance: 50% (2 yr) - Flow frequency
Hypothesis tracking: Curve with flow-value points of 0-0, 600-6, 1000-10, 10000-0
Geographical queries: Not applied

Comments. The background for big bass used statements like "mortality...was caused by a
chronic lack of habitat...generally poor conditions". These are clues that big bass are somewhat
resilient and will be most affected by bad conditions that occur for long periods of time or
sporadically, without enough time between episodes for the fish to recover. This scenario is
unlike little minnow spawning where the eggs cannot have bad conditions — be dry — for any
single day and survive. Relationships like this typically use an initial statistical setting of Means
for the Duration query.

4.1.3 Benthic macroinvertebrate biodiversity

Reservoirs tend to reduce high flows and increase low flows, which creates a more stable flow
regime. In these regulated systems, communities of benthic macro invertebrates often have
reduced biodiversity because the few species that thrive in the more stable flow conditions out
compete all of the others. Flooding initiates a return to more natural conditions which
encourages the community to rebound to its original biodiversity. Scientists maintain that the
timing is not important, but the high flows should occur once every two years, on average.

42



HEC-EFM Quick Start Guide Chapter 4 - Demonstration Project

HEC-EFM Relationship:
e Season: 10/1 to 9/30
Duration: 1 day, Means (average) and then Maximum (high)
Rate of change: Not applied
Percent exceedance: 50% (2 yr) - Flow frequency
Hypothesis tracking: Increased flow will improve (+) benthic biodiversity
Geographical queries: Not applied

Comments. HEC-EFM relationships do not need to be complicated. The background basically
says that benthic biodiversity is a function of high flows. So to build this relationship, use
statistical queries that focus on high flows of short duration at any time in the water year.
Choosing a duration is related to the flashiness of the river system being studied. For the
demonstration project, a value of 1 day was chosen, though any duration between 1 and 7 days
would likely be a good indicator.

4.1.4 Wetland health

Water exchange between river and wetland areas has also been noted as a key component of
wetland health. With frequent exchange, water quality in the wetlands remains good, but with
isolation, dissolved oxygen levels drop, wetland areas become anoxic and aquatic species die.
This scenario is only an issue in the warm summer months, mid-May to mid-September. A
hydraulic engineer on your team has determined that flows of 600 cfs and higher allow water
exchange in your project area and a biologist, familiar with the region, suggests that active
exchange for approximately 30% of the time (in summer) will lead to healthy conditions.

HEC-EFM Relationship:
e Season: 5/151to09/15
Duration: 1 day
Rate of change: Not applied
Percent exceedance: 30% (of time) - Flow duration
Hypothesis tracking: Increased flow will improve (+) water exchange for Wetland health
Geographical queries: Not applied

Comments. This relationship is the first demonstration relationship to use the Percent
exceedance - Flow duration query. In this case, healthy conditions are created when active
exchange between the river and wetlands occurs 30% of the time. As mentioned in the little
minnow comments, using the Percent exceedance - Flow duration option will return a flow and
stage that are equaled or exceeded in the percent of time specified by the user.

4.1.5 Riparian tree recruitment and inundation

Reservoir influence and transition of floodplain lands to agriculture has proved a destructive
combination for riparian tree forests. Through scientific study, riparian tree establishment has
been tied to high flows that occur and recede during germination periods. After germination,
survival is a function of water level. If inundated, seedlings are prone to drowning and,
conversely, if water levels recede too rapidly, roots desiccate and seedlings are lost.
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Germination periods for the riparian tree have been shown to occur between mid-June through
July. Scientists have found that, after germination, if water levels drop by more than 0.58 feet
per week then riparian tree seedlings will have a lower chance of survival. A high stage needs
to occur at least once every 10 years to keep sustainable riparian tree establishment.

HEC-EFM Relationship: Recruitment
e Season: 6/15to 8/1
Duration: 1 day
Rate of change: 0.58 feet per 7 days - falling (stage)
Percent exceedance: 10% (10 yr) - Flow frequency
Hypothesis tracking: Increased flow will improve (+) Riparian tree recruitment
Geographical queries: Not applied

Riparian tree seedlings are sensitive to prolonged periods of inundation. Beginning of August
through mid-September represents the time period immediately following the establishment
season, where riparian tree seeds would most likely drown if inundated for an extended length of
time. 21 days is the estimated length of time that a seedling could be continuously inundated
before it dies. If the sustained inundation is less than 0.5 ft, seedlings are more likely to survive.
Median conditions (2 yr) can be used as an estimate of typical inundation.

HEC-EFM Relationship: Inundation

e Season: 8/1to 9/15

e Duration: 21 days, Minimums (sustained highs) and then Maximum (extent of effective
seedling drowning)
Rate of change: Not applied
Percent exceedance: 50% (2 yr) - Flow frequency
Hypothesis tracking: Increased flow will cause Riparian tree inundation to increase (—)
Geographical queries: Depth (0 to 0.5 ft)

Comments. This scenario actually requires two individual relationships that are used to represent
a single ecosystem dynamic. The real dynamic of interest is the establishment of new riparian
tree seedlings. Establishment occurs when flow and stage conditions are suitable for new
seedlings to begin growing (recruit) and when the new seedlings survive inundation that occurs
later in the growing season.

The recruitment relationship uses the rate of change query. This query starts at the end of the
season and works towards the start of the season one day at a time, checking for violations of the
rate of change threshold. The flow and stage at the time of the last violation in the user-defined
season is recorded as a “seasonal result”. These seasonal results (one pair of flow and stage for
each water year) are then ranked into a frequency table. The statistical result for Riparian tree
recruitment is interpolated as the 10% exceedance value.

The inundation relationship uses a Minimums - Maximum Duration query to compute the flow
and stage that effectively drown or preempt any new recruitment.
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These two relationships are used in combination to represent Riparian tree establishment, with
the difference between recruitment and inundation results being the portion of recruitment that
leads to establishment of new seedlings.

HEC-EFM Combo Relationship: Riparian tree establishment
Primary layer - Riparian tree recruitment
Connected layer - Riparian tree inundation

4.2 Setting up the Model

4.2.1 Creating a New Project and Defining Flow Regimes

1. Open HEC-EFM and use the "File — New" menu option to start a new project. Enter title,
author, and project description into the model information section of the Properties Tab.

2. The dataset for this project is part of the completed demonstration project for HEC-EFM,
which was copied to your computer when the HEC-EFM software was installed. Use the
"Help — Install Demonstration Project..."” menu option to extract the demonstration project to
a directory on your computer or network (Figure 21).

Help

Quick Start Guide

| Install Demonstration Project... %J
View Terms and Conditions for Use

About HEC-EFM

After installing the demonstration project, use the “File -
Open...” menu option in HEC-EFM to open the Rolling River
application.

2

ok [ conce
Bowseforfolder X

Unzip to Folder:

To unzip all files in Rolling River.exe to the :
specffied folder press the Unzip button.

4 Downloads
Run WinZip > Il Desktop
Unzip to folder: > 15;0%3“:
I ick Browse to select location - I [ Browse... -

> Ji Music
> @ videos
[ Overwrite files without prompting L » [ Pictures

> i OSDisk (C2)
> s HDD Data (D:) v
< >
Figure 21. Setting up a working directory.

v @ mhispcC A

— .
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3. Data for the flow regimes are located in "Rolling River Data.dss", which is included in the
demonstration project. The first flow regime acts as a placeholder and must be renamed.
Use the “Edit — Flow Regimes — Rename... ” menu option to open the Rename Flow Regime
interface. In the New name text box, enter Natural and click OK (Figure 22).

Edit

Flow Regimes > | Add...

Relationships > | Rename...

Combo Relationships » Reorder...

Manage Geo Queries... Duplicate...

z = Delete...
Plotting Position Type >
. Import...

Unit System >

Languages N Open DSS Catalog...

Select Arrays Format » Deselect reference timeseries

Set Output Selections... Select all

Apply Output Selections Deselect all

pasE Ut Manage groups...

H?m_ile Missing Da.ta Select group...

Missing Data Identifiers... Deselect group...

Recalculate Ctrl+R Batch add,
Batch add one for many...
Batch delete...
Batch add from HDF file...

Preprocess from HDF file...

Replace parts...
Replace input files...

Batch Recalculate...

Existing: IUseeamenutomnane V[

New name: ’NM I

Figure 22. Naming a flow regime.

4. Add data to this flow regime by moving the cursor over the Filename cell and pressing the
browse button (Figure 23). Browse to the Rolling River folder in the extraction location,
select "Rolling River Data.dss", and click OK. Note: The browse button only appears when
you have the Filename cell selected.

Flow regimes (paired time series of flow and stage)

Ref | Active | Identifier

| Fiename |

| PartB | PartF | Startng | Ending

Natural

Select to browse for new file
Mt <« OSDisk (C:) » User > MyDocuments > HEC-EFM > Rolling River v O Search Rolling River L
Organize v New folder B v [ o
User (A Arrays
My Documents Hydraulics
HEC-EFM Spatial
Rolling River M\ Rolling River Data.dss

Arrays
Hydraulics
Spatial v

File name: IRoIIing River Data.dss

v | [Dssfiles (".dss) vl

I Open !}J l Cancel l‘::

Figure 23. Adding the flow regime data file.

46



HEC-EFM Quick Start Guide Chapter 4 - Demonstration Project

5. Click the Open DSS Catalog button to open the HEC-DSS Catalog Browser for that flow
regime (Figure 24).

Browse to /ROLLING RIVER/AT EFM XS/FLOW//IDAY/NATURAL/, highlight the f-part
"NATURAL" and click Select. HEC-EFM has an auto-mapping feature that looks for stage
time series whose a-, b-, and f~-parts match the selected flow record. If HEC-EFM finds a
match, a message box opens asking whether the matching time series should be used as the
corresponding stage values for that flow regime. Click Yes. Once both the stage and flow
time series have been selected, press OK.

Flow regimes (paired time series of flow and stage)

Ref | Active | Identifier Filename Part A PartB Starting Ending

M  |Natural Rolling River Data.:

“8, HEC-DSS Catalog Browser —

o There is a corresponding stage pathname. Use it?

[ ] I o Selectraingcurve | | Openosswaog...b,}]

as second series

Selected pathnames
(O Flow /ROLLING RIVER/AT EFM XS/FLOW//1DAY/NATURAL/

® Datz2 //INDAYI/
From: To:

Figure 24. Selecting flow and stage time series.

6. Use the "Edit — Flow Regimes — Add..." menu option to open the Add Flow Regime interface.
In the Name text box, enter Gaged and click OK. Repeat steps 4 and 5 to add data to the new
flow regime. Remember to click the Open DSS Catalog... button while the cell highlighted
in the table of flow regimes is in the row for Gaged and to select the f~part "GAGED" after
opening the DSS catalog.

7. Tt is important to define the reference flow regime, which is the flow regime that serves as the
basis for comparison when looking at direction of ecosystem change. In this example, use
the Natural flow regime as the reference. To make a flow regime the reference, click on the
box in the Ref column of that flow regime (Figure 25). In this case, a check mark is already
in the box because Natural was the first flow regime created. Only active flow regimes are
considered during calculations.
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Flow regimes (paired time series of flow and stage)

Ref |Active | Identfier | Filename | PartA PartB PartF | Startng |  Ending
Natural Rolling River Data.dss |[ROLLING RIVEI/ATEFM XS  |NATURAL 01/01/1974 = 09/30/2023
O| O |Gaged Rolling River Data.dss | ROLLING RIVE! AT EFM XS GAGED 01/01/1974 = 09/30/2023

Figure 25. Reference and active flow regimes.
8. The Properties Tab should now look like Figure 26. Use the "File — Save As"” menu option

to save your project. Note: The completed demonstration project is called Rolling River.efm.
If saving in the extraction directory, please use a different name for your project.

File Edit Plot Help

Model information
Title: [Roling River study |
Author: | Rolling River study team I
Location: I
Description: Ecosystem Functions Model demonstration project. A

EFM model pathname:C:\User\My Documents\HEC-EFM\Rolling River\Rolling River.efm

Flow regimes (paired time series of flow and stage)

Ref | Actve | Identfier |  Fiename |  PartA PartB PartF | Startng |  Ending
Natural Rolling River Data.| ROLLING RIVEI AT EFM XS NATURAL 01/01/1974 | 09/30/2023
O O |caged Rolling River Data.[ROLLING RIVEI ATEFM XS |GAGED 01/01/1974 = 09/30/2023

. Open DSS Catalog...

|
Properties Relationships Tables Combo Relationships
he saved to C:\User\My Documents\HEC-EFM\Rolling River\Rolling River.efm Recalculate i

Figure 26. Completed Properties Tab for the demonstration project.

4.2.2 Defining Relationships

1. The next step is to enter the relationships. Go to the Relationships Tab and use the "Edit —
Relationships — Add..." menu option to open the Add Relationship interface. In the Name
text box, enter Little minnow spawning habitat and click OK (Figure 27).
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Edit
Flow Regimes >
| Relationships » [ Add.. I
Combo Relationships » Rename...
Manage Geo Queries... Reorder...
. - Duplicate...
Plotting Position Type »
. Delete...
Unit System >
Import...
Languages 3
Clear all fields
Select Arrays Format >
Set Output Selections... Options list... Name: [Lifie minnow spawring habitat I
Apply Output Selections Select all
Parse Output Deselect all 1
Handle Missing Data Manage groups... I 2. !:g { ’
Missing Data Identifiers... Select group...
Recalculate Ctrl+R Deselect group...

Figure 27. Adding a relationship.

2. Enter a description, statistical queries, and hypothesis for the Little minnow spawning habitat
relationship (Figure 28).

File Edit Plot Help

Relationship name: |Little minnow spawning habitat v E]' W:ite on arrays (2] Active
Description: Little minnow spawn in shallow vegetated floodplain areas ) N :
between February and May. Eggs require sustained high [ Hypothesis tracking - increased flow will
flows for approximately 21-to 28-days before hatching. Good + - health
spawning conditions need to occur, on average, at least @ O O @} oo
once every four years. [] Confidence tracking: 4 3% 3%3% 3%
Index A B C D E
Statistical queries Geographical queries Other queries (nonstandard)
[ Seaon [[] Reverse lookup: Flow Stage
From: (02/01 (mvd) Value cfs

To: (m/d) Values per [NEGWREGTE

[ Duration of days Range to cfs
For each duration, compute: Ranges per [EIOWIHESITE
Minimums V|
lirgn,,mla!ug.seledﬂ\ei Handle out of range with 0
Mmm v| Count number of peaks between
[J Rate of change: @) Stage O Flow = =
[:] feet per days [] Ecovalue summation:
O Rising @ Falling O Absolute Last computed time series v
Time series specifications ——— Eor Conmotaid Romes reckios
™ '/. exceedance (4.00-yr) Multiv y SEttings
(® Flow frequency O Flow duration Apply paired fzbles
D |:] to D Water year range Output total for whole flow regime
- - R ris: res no
DI: Individual water year et o r
[[] Relationship-defined water year Flow duration: Analyze seasons
" V} Return % exceedance of
Properties Relationships Tables Combo Relationships
Recalculate

Figure 28. Statistical queries and hypothesis for the Little minnow relationship.
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3. Click the Recalculate button (bottom right of the interface). Results are displayed on the
Tables Tab (Figure 29).

File Edit Plot Help
Evaluated on: 05/31/2020 12:53 A
Summary
Natural
Relationship Conf. Stage, ft Flow, cfs
Little minnow spawning habitat n/a 4,275.2 1,226 v
Properties Relationships Tables Combo Relationships
Recalculate

Figure 29. Statistical results for the Natural flow regime and the Little minnow relaﬁonship.

4. Next, click on the Properties Tab; activate the Gaged flow regime by checking its box in the
Active column of the flow regime table. Click the Recalculate button. Results are now
displayed for both the Natural and Gaged flow regimes (Figure 30).

Note: It is important to recognize that the Little minnow relationship was not changed during
this step. Flow regimes and relationships exist independently. When the second flow
regime (Gaged) was activated, HEC-EFM computed statistical results for each flow regime
using the same statistical criteria, as defined for the Little minnow relationship. Results are
different because each flow regime has its own distinct patterns of flow and stage.

File Edit Plot Help
Evaluated on: 05/31/2020 12:58 A
Summary
Natural Gaged
Relationship Conf. Stage, ft Flow, cfs Chg. Stage, ft Flow, cfs
Little minnow spawning habitat n/a 4,275.2 1,226/ Pos 4,275.7 1,703
Properties Relationships Tables Combo Relationships
Recalculate s

Figure 30. HEC-EFM statistical results of the Little minnow spawning habitat relationship using
both the Natural and Gaged flow regimes.
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5. The next step is to create geographical queries. Go to the Relationships Tab and use the
"Edit — Manage Geo Queries..." menu option to open the Manage Tags for Geographical
Queries interface (Figure 31). Click the Add tag... button to open the Add Tag interface. In
the Name text box, enter "Depth" and click OK. Repeat this step to add tags named
"Vegetation" and “Land Use”. Now associate the tags with Little minnow spawning habitat
by highlighting that relationship in the Relationship column and clicking the Select tags...
button. The Tag Selector interface will open. Select Depth and Vegetation and click the Add
- button. Click OK to save the selections to the Manage Tags interface and then click OK
in the Manage Tags interface to save the tags and selections to the project. Text boxes for
selected tags will appear on the Relationships Tab. Enter a description for each of the Little
minnow tags. For Depth, enter “Shallow habitat 0 to 3 ft”. For vegetation, enter “Requires
presence of aquatic plants” (Figure 32).

Edit | Plot Help

Flow Regimes »

Relationships >

Name: |(Depth

Combo Relationships »

Manage Geo Queries... [

oy [

Plotting Position Type » Project tags
. Tags are simple names that identify sets of spatial data layers ighportant to an EFM
Unit System » project. Project tags are available for use in each relationshipg/The following tags have
Languages ) been created for this project:
Select Arrays Format » Depth, Vegetation, Land Use
Set Output Selections...
Apply Output Selections
Parse Output
Handle Missing Data Activate tags for each relationship
Missing Data Identifiers... Relationship Selected Tags 5
Litle minnow spawning habitat :Depth, Vegetation 1208.
Recalculate Ctrl+R e INOW Spawring A
£
Unselected tags Selected tags
Land Use Depth
Vegetation
Add ->
<- Remove
S e
<~ Remove Al
Apply Cancel
Figure 31. Adding geographical query tags.
Geographical queries
Depth Shallow habitat 0-
. . . to 34t
Figure 32. Geographical queries for the
Little minnow spawning habitat e Ros
) N Vegetation equires presence
relationship. of aquatic plants
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6. Repeat steps 1 through 5 for the other relationships (Big bass winter habitat, Benthic
macroinvertebrate biodiversity, Wetland health, and Riparian tree recruitment and
inundation).

7. Turn on Confidence tracking for the relationships (Figure 33). For now, leave all
relationships at one star.

Options
[[] Write computation arrays Active
Figure 33. Confidence tracking [ Hypothesis tracking - increased flow will
and indices. @+ O- O/ Cuve | eco-health

[] Confidence tracking: 4% 3%3% 3%
IndexE MA &8 [Jc o [JE

Enter a brief description for each index that you plan to use.

Relationships
Index | Description |Little minnow spawning habitat |Big bass winter habitat |Benthic macroinvertebrate biodiversity \Wetland health |Riparian tree recruitment |Riparian tree inundation
A Al 2 2 2
B Fish v O O O O
C O O O O O O
D O O O O O O
E O O O O O O

oy [ | [ o

8. Next, create indices by clicking the Index button in the Options frame (Figure 33). The Index
Manager interface will open. Enter "All" for index A and "Fish" for Index B. Associate
each relationship with the appropriate indices by checking box A for each of the relationships
and also checking box B for Little minnow and Big bass relationships.

9. Your project should now have 2 flow regimes, 6 relationships, and 2 indices. Use the "File —
Save" menu option to save your project and then click Recalculate to compute results.

4.2.3 Results

Four of the six relationships show a positive change for the Gaged flow regime (Figure 34).
Riparian tree inundation and Benthic biodiversity show a negative change. Benthic biodiversity
had the most significant change in terms of difference in flow results.

Summary
Natural Gaged
Relationship Conf.  Stage, ft | Fow,cfs Chg. | Stage, ft | Flow, cfs
Little minnow spawning habitat = 4,275.2| 1,226] Pos 4,275.7 1,703
Big bass winter habitat i 4,274.1 525| Pos | 4,274.3 609
Benthic macroinvertebrate biodiversity | * 4,279.4 6,620 Neg 4,277.2 3,190
Wetland health ‘* 4,274.3 636> Pos 4,274.5 771
Riparian tree recruitment . 4,274.9 1,017| Pos 4,275.1 1,129
Riparian tree inundation = 4,273.7| 373i Neg | 4,274.3| 609‘

Figure 34. Summary of HEC-EFM results.
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The index values show a negative response (Neg) for all relationships and a positive response
(Pos) for the fish (Figure 35). A positive value suggests that the positive changes outweigh the
negatives for the relationships in the index.

Index

Values
Index Gaged
A-All -4.7
B-Fish 27.4
Figure 35. Index values for “All”

relationships and only the relationships
that are related to "Fish".

The Rolling River has been a popular study area for wetland research. This popularity has led to
numerous peer reviewed studies and an abundance of field data. As these studies support the
approach used to define Wetland health, change confidence for that relationship to five stars
(Figure 36). Leave all others at 1 star.

Confidence tracking: 4% % % %

Figure 36. Confidence tracking increase
for the Wetland health relationship.

Click the Recalculate button. Note that the index value for all relationships goes from negative
to positive (Figure 37). Indices are best used as screening tools. Lumping multiple, and pseudo-
independent, relationships into one numeric index is an approach to be used with caution.

Index

Values
Index Gaged
A - All 9.5
B - Fish| 27.4
Figure 37. Index values after a

confidence tracking increase for the
Wetland health relationship.

Let’s also look at Wetland health with a Reverse lookup query. To do this, use the "Edit —
Relationships — Duplicate...” menu option to open the Duplicate Relationship interface. In the
Name text box, enter Wetland health reverse lookup and click OK (Figure 38).
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Edit |
Flow Regimes 3
| Relationships » | Add...
Combo Relationships v Rename...
Manage Geo Queries... Reorder..
. . Duplicate...
Plotting Position Type »
. Delete...
Unit System >
Import...
Languages >
Clear all fields
Select Arrays Format >
Set Output Selections... Options list...
Bosh ke Sctions T Name: |Wetland health reverse lookup
Parse Output Deselect all
Handle Missing Data Manage groups... @ Cancel
Missing Data Identifiers... Select group...
Recalculate Ctrl+R Deselect group...

Figure 38. Duplicating a relationship.

Turn on the Reverse lookup query by checking its box in the Other queries frame. Enter 600 cfs
in the text box (Figure 39). Notice that percent exceedance is now grayed out because reverse
lookups do not compute a flow based on percent exceedance. Instead, the user specifies a flow
and HEC-EFM computes the percent of years or percent of time that flow is equaled or
exceeded. Note: Non-standard queries (e.g., reverse lookups) cannot be included in the indices.
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File Edit Plot Help

1 Options

Relationship name: :Wdlmd health reverse lookup [] Wite fonamrays [ Acive

Description: —
pR:,c"e"ee . fﬂ‘;?ﬂfw’:eeqvx;"xxwfmmﬂ gt fodks ot [] Hypothesis tracking - increased %X wil
©+ O- OCu-veGOO'heam‘
[ Confidence tracking: 4 3%3%3% 3%
Index A B c C E
Statistical queries Geographical queries Other queries (nonstandard)
B/ Season [“] Reverse lookup: @) Flow ) Stage
From: [05/15 | (m/d) @® Value (600 Jcfs
To: (m/d) O Values per HowRearme
[ Duration of D days (O Range to cfs
For each duration. compute: (O Ranges per = Flow Feaine
Means v )
From computed values, select the: [] Handle out of range with 0 or 100
Maximum v Count number of peaks between
[J Rate of change: (=) Stzge ) Flow and cfs
feet per days [] Ecovalue summation:
Fising () Falling i ) Absolute Last computed time series v
Time series specifications For compound flow regime
£ 30 % exceedance (of time) NIGT I o o i
O Flow frequency @) Flow duration Apply paired data {=bles
D‘:] to |:] WWater year range Output total for whole flow regime
Report parts: s no
D‘:] Individual water year St - :
[[] Relationship-defined water year St e e e
' v Return % exceedance
Properties Relationships Tables Combo Relationships
Recalculate

Figure 39. Reverse lookup for the Wetland health relationship in HEC-EFM.

Results for Wetland health reverse lookup show that both flow regimes were above the 30%
criteria (Figure 40). Results for the Gaged flow regime (67.1%) nearly doubled the 34.1% of
time Natural flows in Rolling River equaled or exceeded 600 cfs.

Reverse Look-ups - Flow Duration

Natural Gaged
Relationship Conf. %X, of time Chg. %X, of time

Wetland health reverse lookup * 34.1| Pos 67.1

Figure 40. Reverse lookup for Wetland health showing percent of time flows above 600 cfs.
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4.2.4 HEC-EFM Output

In addition to the statistical results that are output to the Tables Tab, HEC-EFM also generates a
project summary report and files of the computations it performs while generating the statistical
results. To view the project summary report, use the "File — Report” menu option.

By default, computation files are not generated automatically by the software in order to
minimize computation time. This output option is selected individually for each relationship. To
test this feature, go to the Relationships Tab, select the Big bass winter habitat relationship, and
check the box next to Write computation arrays in the Options frame (Figure 41).

Options
Write computation arrays Active

Hypothesis tracking - increased flow will
O+ O- @ | Cuve | ecohealth
Confidence tracking: 4 3% 3%3% 3%

index MA MB [JC[D[JE

Figure 41. Checking the Write computation arrays box.

Output formats are selected via the “Edit — Select Arrays Format” menu option. Choices are
provided for XML, DSS, or Both. Select Both and click the Recalculate button (Figure 42). A
folder named "Arrays" will be created in the directory of the HEC-EFM project file to store the
output. Edit

Flow Regimes
Relationships >

Combo Relationships

Manage Geo Queries...

Plotting Position Type 4
Unit System >
Figure 42. Output choices via the Eangusges 4
Select Arrays Format menu options. Select Arrays Format » | DSS
Set Output Selections... XML
Apply Output Selections ‘
Parse Output

Handle Missing Data
Missing Data |dentifiers...

Recalculate Ctrl+R

The term XML stands for Extensible Markup Language. XML is a widely used format for
archiving and viewing data. Separate XML files are generated for each combination of flow
regime and relationship. Each of these files contains the computational steps, statistical results,
and frequency curves produced by HEC-EFM. The XML arrays are organized such that the final
results are located at the top of the file followed by each computational step in reverse order
(Figure 43). Using the "File — View Array File..." menu option, select "Gaged Big bass winter
habitat.xml" and click Open.
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Figure 43. Excerpt from the XML HEC-EFM computational arrays
output file for Big bass winter habitat
and the Gaged flow regime. This page shows intermediate computational arrays from the following analyses.

Choose the go link to jump to a particular analysis.

1. Time series record: Gaged, relationship: Big bass winter habitat go

Gaged, Big bass winter habitat

Computations made: 07/09/2024 14:23, Rolling River.efm
Result: Flow = 608.5 , Stage = 4,274.3, Closest water year = 1989
Eco-value = 6.1

Water years omitted due to missing data: None
Frequency analysis
Plotting position: Weibull

Rank Frequency WY Flow Stage

1 01961955 868.0/4,274.7
103921993/ 867.9 4,274.7
0588 2004/ £07.6 4,274.6

07841958 776.6/4,274.5 1Q 1 1 1
o el e This 1s the statistical result

11761997/ 760.9/4,274.5 for the Big bass winter
1373[1996|745.4/4,274.5 . . :
15692003 742.4/4,274.5 habitat relationship and

.1765/2018| 735.9/4,274.5 .
.1961/1992|705.94,274.4 Gaged flow r egime. A

.2157/2010,693.3/4,274.4 W g ¥ . .
eIl TMA statistical result 1s the pair

T of flow and stage that meet
127451986 675.1/4,274.4

2541/1978/668.414,274.4 the statistical criteria used.
.3137/2011/666.5 4,274.4
.3333/1974 657.34,274.4
.3529/1999650.8/4,274.3
.3725/2013/650.1/4,274.3
.3922/1580 642.6/4,274.3
4118 1934 638.6 4,274.3
4314/1990 637.6/4,274.3
.451/1991/632.2/4,274.3
47061588 624.3 4,274.3
4902/1589 612.6/4,274.3
.5 608.5 4,274.3

26 5058|1987, 604.54,274.3

" caaalvansicoo 0la 924 o

Wiy n s W N

I A A
A s WN = o

I N R N R R N A A
VE WN =S WL e

The highlighted value is the statistical result. The table also contains seasonal results for each
historical water year in the period of record. This type of information provides more details
about the relationships and flow regimes than the statistical results reported on the Tables Tab
and can be very valuable to HEC-EFM applications.

These same data are stored in a file named "arrays.dss" and are archived according to flow
regime and relationship names. The "arrays.dss" file can be accessed using HEC-EFM Plotter or
HEC-DSSVue, which are available via the HEC website (http://www.hec.usace.army.mil).
Figure 44 shows the catalog of data output to DSS for the Big bass winter habitat relationship,
time series calculations done to compute seasonal results for the Natural flow regime, and
frequency curves of seasonal results for Natural and Gaged flow regimes with the 50%
exceedance values selected as the statistical results.
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File Edit View Display Groups DataEntry Tools Other Functions Advanced Help
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File Name: |C:\User\My Documents\HEC-EFMRolling River\Arrays.dss
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Arrays.dss X
Search A v| C v| E v
By Bartal o: v| D v F v
Number  PartA PartB PartC PartD /range PartE PartF
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4|GaGeD [BIG BASS WINTER HABITAT _|FREQ-FLOW X2 - STATISTICAL RESULT
5/GAGED [BIG BASS WINTER HABITAT _ |FREQ-FLOW  [1974-2023 X1 - FREQUENCY CURVE
6/cAGED [BIG BASS WINTER HABITAT _|STAGE 01Jan1974- 131un2023  [1DAY [T1 - SEASONAL EXTRACTS
7INATURAL  [BIG BASS WINTER HABITAT _ [FLOW 01Jan1974- 13un2023  [1DAY [T1- SEASONAL EXTRACTS
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10[NATURAL  |BIG BASS WINTER HABITAT _|FREQ-FLOW X2 - STATISTICAL RESULT
11NATURAL  |BIG BASS WINTER HABITAT [FREQ-FLOW  [1974-2023 [X1 - FREQUENCY CURVE
12[NATURAL  [BIG BASS WINTER HABITAT |STAGE 013201974 - 13un2023  [1DAY [T1 - SEASONAL EXTRACTS v
Arrays.dss:NATURAL /BIG BASS WINTER HABITAT/FLOW/01Jan1974 - 13Jun2023/1DAY/T1 - SEASONAL EXTRACTS/ ~ : . LT .
[Arrays.dss:NATURAL BIG BASS WINTER HABITAT/FLOW/01an1974 - 31May2023/1DAY/T2 - MEANS/ Time Series Plot: Time series
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Arrays.dss: NATURAL/BIG BASS WINTER HABITAT/FREQ-FLOW/1974-2023//X1 - FREQUENCY CURVE/ and seasonal results
Arrays. dss: /GAGED/BIG BASS WINTER HABITAT/FREQ-FLOW///X2 - STATISTICAL RESULT/
Arrays.dss:/GAGED/BIG BASS WINTER HABITAT/FREQ-FLOW/1974-2023//X1 - FREQUENCY CURVE/ gener ated by HEC-EFM for

Select De-Select
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Figure 44. Catalog of HEC-EFM data output to DSS for the Big bass winter habitat relationship.
Seasonal results for the Natural flow regime as well as a frequency curve of seasonal results for
Natural and Gaged flow regimes are shown.
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4.2.5 Using HEC-EFM Plotter

HEC-EFM Plotter is designed to help users view output and compare results for different flow
regimes and relationships. Additionally, by displaying each computational step that HEC-EFM
performs while analyzing time series, HEC-EFM Plotter offers an opportunity to understand the
statistical process and settings being used to investigate each relationship.

EFM and EFM Plotter are separate software. To work together properly, EFM needs to know
where Plotter is installed. In versions 1.0 and 1.1 of Plotter, the only standard way to install the
software was via an install package that guided users through the install process. Users were
encouraged to install Plotter to a consistent location such that subsequent installations would
replace the existing version and leave only one version of the software available for use on a
single computer. EFM used information written to the computer registry during install to locate
and connect with Plotter.

Now, and especially with versions of Plotter that allow users to install the software by simply
extracting it from an archive of files, it is more common to have multiple versions of Plotter
available for use on a single computer. To support multiple versions and existing projects that
users may want to continue applying with earlier software, connections between the two software
have been made available for users to manage. Importantly, this change was made after release
of EFM 4.0. EFM 4.0 users are encouraged to continue to install Plotter, whether 2.0 or earlier,
to a consistent install location using the install package.

Connections between EFM and Plotter in EFM 5.0 and later are managed via the “Plot —
Manage Version-Specific Locations” menu option. An interface will appear that allows the user
to enter the EFM version number and open a file browser to identify the associated version of
Plotter (Figure 45). If Plotter is launched from an unlisted version of EFM, the default location
of Plotter will be used. If Plotter is not available at that location, a message will be returned to
inform the user that EFM is unable to locate Plotter and ask the user to verify that Plotter is ready
for use. The “Plot — Specify HEC-EFM Plotter Location” menu option is used to update the
default location of Plotter.

4-19



Chapter 4 - Demonstration Project HEC-EFM Quick Start Guide

Plot

Activate HEC-EFM Plotter

Specify HEC-EFM Plotter Location

I Manage Version-Specific Locations L} I—l

HEC-EFM Version | HEC-EFM Plotter Location A
Default C:\Program Files (x86)\HEC\HEC-EFM Plotter\3. 1\HEC-EFMPlotter.exe
4.1.036 C:\Programs\HEC\HEC-EFM Plotter\2019-03-14\HEC-EFMPlotter.exe
4.1.038 C:\Programs\HEC\HEC-EFM Plotter\2019-05-22\HEC-EFMPlotter.exe
5.0.051 C:\Programs\HEC\HEC-EFM Plotter\2022-07-18\HEC-EFMPlotter.exe
6.0.023 IC: \Programs\HEC\HEC-EFM Plotter\2024-06-28\EFM_PLOT-4.0.033\HEC-EFMPlotter.exe

X
&
OK Cancel

= v <« Programs > HEC > |HEC-EFM Plotter > 2024-06-28 > EFM_PLOT-4.0.033 v O Search EFM_PLOT-4.0.033 yel
Organize v New folder == v A o
2024-06-23 A Name Date modified Type Size
2024-06-28 config 6/28/2024 1:12 PM File folder
EFM_PLOT-4.0.033 jar 6/28/2024 1:12 PM File folder
config jre 6/28/2024 1:12 PM File folder
jar lib 6/28/2024 1:12 PM File folder
jre ‘. HEC-EFMPlotter.exe 6/28/2024 1:12 PM Application 685 KB
lib v
File name: lHEC-EFMPIotter.exe vl »EXE Files (*.exe) v
* L

Figure 45. Connections between HEC-EFM and HEC-EFM Plotter can be managed to ensure
proper software behaviors and to associate different versions of the two software.

Plotter is initiated via the “Plot — Activate HEC-EFM Plotter” menu option. DSS output is
automatically imported to Standard Plots for each combination of flow regime and relationship.
The Relationship dropdown list in the upper left hand corner of the main interface is used to
select which relationship is displayed (Figure 46; Big bass winter habitat relationship). The
Flow Regime dropdown list controls the flow regime being viewed (e.g., Natural or Gaged).
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Figure 46. HEC-EFM Plotter showing results for the Big bass winter habitat relationship with the
Natural flow regime.

Custom Plots are useful when comparing results for multiple relationships or flow regimes.
Select the Custom Plots option and add a Custom Plot called “Bass Compare” by choosing
Add...from the Custom Plots dropdown button (Figure 47).

(® Custom Plots [w ”
. R
ename...

Reorder...

| Save active view as new Custom Plot...
[] view results fg

M1 lea matbris i

Delete...

Name: ‘Bass Compare

[] Area Plot [] New Colors [I'k‘\ | Cancel

Figure 47. Adding a custom plot.
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Click the DSS Selector button and browse to the arrays.dss file for your project. Select all

records with a b-part of Big bass winter habitat and click the Set Pathname button (Figure 48) to
import those data to the “Bass compare” plot (Figure 49).

v |4

File Edit View Display Groups Advanced

—Lg[Open
File Name: |

Arrays.dss|

Pathnames Shown: 0

Search A
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Pathnames Selected: 0

File Edit View Display Groya Advanced
. Goen )

Pathnames in Fie: 0

File Size: 0 KB

Library Version: 6-WB

PartD /range
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Pathnames Shown: 45

C:/User/My Documents/HEC-EFM/Rolling River/Arrays/Arrays.dss

Pathnames Selected: 1466 Pathnames in File: 2378

File Size: 4.81 MB

File Version: 6-WB Library Version: 6-WB

Search A v, C & E |
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Number PartA PartB PartC PartD /range PartE PartF
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9|GAGED |BIG BASS WINTER HABITAT FREQ-DATE SHIFT 1974-2023 EX - DATE SHIFT
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14/GAGED |BIG BASS WINTER HABITAT FREQ-SUMMATION 1974-2023 EX - TALLY SEASONAL RESULTS
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Figure 48. Process for selecting Big bass winter habitat results for comparison in a custom plot
within HEC-EFM Plotter.
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Figure 49. Custom plot in HEC-EFM Plotter comparing ecovalues of the Big bass winter habitat
relationship for Gaged and Natural flow regimes.

HEC-EFM Plotter has many features for navigating (zoom, hover, snap to water year,
advance/retreat a year) and viewing data sets (plot markers, show/hide/reorder data sets via the
legend, axis settings, toggle plots with a Ctrl-T command).

HEC-EFM Plotter and HEC-EFM can be open at the same time. In fact, when a setting is
changed in HEC-EFM and a Recalculate is performed, plots can be updated by clicking the
Refrresh button, which makes HEC-EFM Plotter an effective way for teams to explore and refine
the statistical settings that define the relationships.

4.3 Hydraulic Analysis

Spatial analysis of HEC-EFM results can be done using water surface profiles and grids of depth
and velocity produced by a geo-referenced hydraulic model. Past applications of HEC-EFM
have used HEC-RAS, HEC-GeoRAS, and HEC-RAS Mapper, which can be found on HEC’s
website http://www.hec.usace.army.mil/. Documentation on use of these software is also
available at the website.
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4.3.1 HEC-RAS

The HEC-RAS software is used to simulate one-dimensional steady flow, one-dimensional and
two-dimensional and combined one- and two-dimensional unsteady flow, sediment transport,
and water temperature (Figure 50) in riverine systems. Water surface profiles can be rendered
with HEC-RAS Mapper and exported to GIS for spatial analysis.
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Figure 50. Example of HEC-RAS used to create water surface profiles for HEC-EFM statistical
results (Riparian tree recruitment and inundation relationships using the Natural flow regime.)
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4.3.2 HEC-GeoRAS and HEC-RAS Mapper

HEC-GeoRAS and HEC-RAS Mapper are software that assist with spatial operations related to
the HEC-RAS river hydraulics model. HEC-GeoRAS is a set of procedures, tools, and utilities
for pre and post-processing geospatial data in ArcGIS® (Figure 51). With these software, water
surface profile data can be used with a digital terrain model to calculate depth grids, velocity
grids, and floodplain boundary polygons.

RAS Geometry ~ RAS Mapping~ 5¢ N¢ || & < < & ApUtilities~ Help~ s
Table Of Contents R x E——

2¢8
[ER=Anewras_current_5_natural

# [ bInundation

® d Inundation

# [ tInundation

# [ bRecuitment

# [ dRecuitment

#® [ tRecuitment

# [ water Surface Extents
# [0 %S Cut Lines

# [0 Bounding Polygon

® existing_clipped

Figure 51. Example of a depth grid computed in HEC-GeoRAS using the water surface profile
simulated by HEC-RAS for the statistical results of Riparian tree inundation from HEC-EFM.

44 HEC-EFM Analyses with GIS

Geographic information systems are technologies used to store, manage, edit, analyze, and
display data that are spatially referenced to the earth. Using GIS in an application of HEC-EFM
allows users to analyze data layers produced by HEC-RAS as well as any external data sets that
have ecological significance. The following sequence of figures is an example of how GIS can
be used to investigate ecosystem response spatially. Results are shown for Riparian tree
establishment dynamics in the Natural flow regime. Depth grids were initially created for
recruitment (Figure 52) and inundation (Figure 53). The inundation layer was then placed on top
of the recruitment layer (Figure 54).
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Figure 52. Depth grid created for Riparian tree recruitment. The green area shows where stage
recession creates suitable conditions for seedlings to begin to grow.
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Figure 53. Depth grid created for Riparian tree inundation. This blue area shows where any new
seedlings will be drowned by prolonged inundation.
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Figure 54. Overlay of Riparian tree recruitment and Riparian tree inundation depth grids.

In accordance with the combo relationship for Riparian tree establishment (Figure 7), the
inundation depth grid was clipped from the recruitment depth grid. The resulting layer shows the
area where HEC-EFM predicts Riparian tree establishment (Figure 55).
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Figure 55. Depth grid created by clipping the inundation depth grid from the recruitment depth
grid. The resulting area shows where HEC-EFM predicts Riparian tree establishment.

Information for the Riparian tree inundation relationship mentioned that seedlings were more
likely to survive if sustained inundation did not exceed 0.5 ft. Delineating the area of inundation
less than or equal to 0.5 ft shows the portion of Riparian tree inundation that may not lead to
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seedling mortality (Figure 56). This Riparian tree inundation fringe can then be layered with the

clipped layer to create a new view of predicted and possible (due to the shallow depths) Riparian
tree establishment (Figure 57).
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Riparian_tree_inundstion_depth_grid
Walue

High : 222035

Lo - O DD 4281

Inun daden Frings

=

Figure 56. The yellow fringe shows areas of the Riparian tree inundation depth grid that are less
than or equal to 0.5 ft, which may not be deep enough to drown new seedlings.
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Figure 57. Potential recruitment sites for the Rolling River's Natural flow regime as computed
using statistical and geographical queries in HEC-EFM, water surface profiles computed by HEC-
RAS, and depth grids produced by HEC-GeoRAS.

4-28



HEC-EFM Quick Start Guide Chapter 4 - Demonstration Project

So far the demonstration project has focused on comparing flow regimes with different
hydrologic scenarios (Natural vs. Gaged). HEC-EFM can also be used to look at changes in
topography, which will change the stage time series without changing the flow. Figure 58 shows
a comparison of the current topography and a planned restoration project that increases stream
meander. The same flows (Natural) are used for each of the channel topographies.

Rolling River existing
topography

Riparian tree
establishment area =
6.3-acres

Rolling River design
| topography

[| Legend

Riparian_tree_recruitmert_depth_grid B -
Ve Riparian tree

Hgh:5.81748 establishment area =
3.3-acres

- Low © 0000455351 I

Figure 58. Comparison of Riparian tree establishment in existing and restored topographic
conditions.

The following progression of tasks for the demonstration project has now been completed: 1)
building relationships, 2) setting up an HEC-EFM project and computing statistical results, 3)
simulating the statistical results with a hydraulic model, and 4) use of GIS to investigate
ecosystem responses spatially.

Statistical results in HEC-EFM are computed as flows and stages, percent exceedances, index
values, and directions of ecosystem change. Spatial results are shown as combinations of map
layers with each combination presenting a snapshot of an ecosystem dynamic. Layers are
typically translated to areas for spatial comparisons of different flow regimes and channel
topographies. Working with GIS allows use of other ecologically relevant data. For example, a
soils map for Rolling River could be used to intersect the Riparian tree establishment layer
(Figure 55) with the extent of suitable soils for riparian trees.

441 HEC-GeoEFM

The process of applying HEC-EFM involves three basic phases: statistical analyses, hydraulic
modeling, and use of GIS. Results from the statistical phase are input to external hydraulic
models that generate layers of water depth, velocity, and inundation, which are then used in GIS
to investigate spatial criteria and results for the flow regimes and relationships being analyzed.
Application of the full process can generate many layers.
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HEC-GeoEFM is a software tool developed to support spatial analyses commonly used during
applications of HEC-EFM. HEC-GeoEFM provides three primary capabilities for planning
ecosystem restoration projects or water management decisions: 1) management of spatial data
sets, 2) computation and comparisons of habitat areas, and 3) assessment of the habitat
connectivity. HEC-GeoEFM works with HEC-EFM and HEC-EFM Plotter to help users assess
the ecological implications of water resource decisions. For more information, please see
http://www.hec.usace.army.mil/software/hec-geoefm/.
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CHAPTER 5

Applying HEC-EFM

Applications of HEC-EFM focus on aquatic habitat and land-water interactions inside the
maximum inundated area associated with a river, wetland, or reservoir. Within this domain, the
software is capable of testing a diverse and extensive array of management scenarios and
ecological relationships. The software relies wholly on the user to define which aspects of the
ecosystem are of interest (e.g., fish, vegetation, benthic macroinvertebrates), how those are to be
investigated (e.g., at a single diagnostic location, for multiple locations, for many spatial areas),
and which hydrologic, operational, or restoration scenarios are considered (e.g., climate change,
reservoir releases, channel manipulation). This flexibility in focus, scale, and scenario is an
important and defining aspect of HEC-EFM. 1t is also difficult to fully appreciate.

5.1 Leveraging Existing Applications

Applications of HEC-EFM are easy to initiate and can also borrow from existing applications.
Incorporating pieces of existing models is done through menu options for import of both flow
regimes and relationships. When “Edit — Relationships (or Flow Regimes) — Import...” is
clicked, an interface will appear that allows users to browse to an existing (source) application,
select the desired flow regimes or relationships, and perform the import (Figure 59). “Import...”
is the only menu option that connects multiple model applications. All others (e.g., add, rename,
reorder, duplicate, delete, select/deselect, manage and select/deselect groups) work within the
open application. Please note that the “Edit — Relationships” menu is location-dependent and is
only enabled when the user is working on the Relationships Tab. This restriction is also the case
for the “Edit — Flow Regimes and Combo Relationships” menus (Properties Tab and Combo
Relationships Tab, respectively).

Edit

Flow Regimes

Relationships > Add...
a . Select relationships to import
Combo Relationships » Rename... =]
- Rolling River.efm Source: Meandering River.efm | (7
i eorder... -
Manage Geo Quenes = DibhGat Little minnow spawning habitat Shadowy shiner |
. - uplicate... Big bass winter habitat Migratory waterfowl
piering Postien Type ' Delete G
Unit System N Wetland health Mussel - Host fish interactions
Import... —»| |Riparian tree recrutment Recruitment of Iaie wooa debris
Languages > Riparian tree inundation Island nesting habitat
Clear all fields Wetland health reverse lookup
Select Arrays Format » << Import All
Set Output Selections... Options list...
Apply Output Selections Select all
Parse Output Deselect all
Handle Missing Data Manage groups... ¢ - : :
Missing Data Identifiers... Select group...
Recalculate Ctrl+R Deselect group... Cancel

Figure 59. Using the “Import...” menu option to add relationships from source to current project.
This can also be done for flow regimes.
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5.2 Large-Scale Applications

The simplest HEC-EFM applications involve one flow regime and one relationship as would be
the case when modeling the effects of one scenario on one aspect of the ecosystem. Applications
become more complex as the numbers of flow regimes and relationships increase. HEC-EFM
models that investigate many alternatives for only a few species are likely to have a higher
number of flow regimes and a low number of relationships. Conversely, modeling done to better
understand the status of whole ecosystems will tend to have a low number of flow regimes and a
higher number of relationships. As spatial scales increase from a single restoration site to long
reaches in dendritic river systems, HEC-EFM applications often have location-based flow
regimes that serve as multiple diagnostic locations for a single management alternative. The
number of relationships may grow as relationships are duplicated and modified to test model
sensitivities. HEC-EFM has several features to help support this spectrum of applications.

5.2.1 Batch Creating Flow Regimes

To expedite addition of multiple flow regimes, HEC-EFM offers two features that automate
creation of new flow regimes. Both are available through the “Edit — Flow Regimes” menu
(Figure 60). “Batch add...” works only with data stored in HEC-DSS. Users specify input data
file, types of data to associate with the flow regimes, and naming convention for flow regime
identifiers. HEC-EFM will process all data in the input file per the selected data type. For
example, the data file (Rolling River Data.dss) provided with the demonstration project has four
records: Rolling River, flow and stage for both Natural and Gaged conditions. If that file was
used in a batch add with a data type of Flow and Stage, two flow regimes would be added.

I Flow Regimes » | Add...

Relationships ¢ Rename... This feature automates creation of flow regimes. It works only with time series data
Combo Relationships > Reorder... archived in the HEC Data Storage System (HEC-DSS). Please use this feature with
caution. Itis capable of creating many flow regimes. which can be difficult to undo.

Manage Geo Queries... Duplicate...
Delete... Flow regimes input file
Plotting Position Type 4 iy
Unit System » Import... Rolling River Data.dss
Languages N Open DSS Catalog...
Select Arrays Format R Deselect reference timeseries Select data type (c-partin DSS)
i Flow and S v | FLOW
Set Output Selections... Select all w fage
Apply Output Selecti
Gk e Name of flow regime identifiers to be created
Parse Output

Manage groups.. (O DSS Pathname Part A

Handle Missing Data Select
e TP (® DSS Pathname Parts: Prefix A v|  -suffix F v

Missing Data Identifiers... Deselect groiip.:

3 - Suffix
O Prefix ? 1
Recalculate Ctrl+R ! Batch 2dd... (integer)
Batch add one for many... Set period of record (optional)
Batch delete... Starting (] &/ 12020 @~ Ending |[] 6/ 1/2020 @~

Batch add from HDF file...

Associate with group (optional)
O INew New: Ente

Replace parts... 2flow regimes added.

Replace input files...

Preprocess from HDF file...

Activate added flow regimes (optional)

Batch Recalculate... Make "Active”

Figure 60. “Batch add...” and “Batch add one for many...” automate creation of flow regimes.
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With “Batch add one for many...”, users specify the two data time series to use, the number of
flow regimes to create, and a naming convention for the resulting flow regimes. Each of the
flow regimes have the same time series data, which can be advantageous when investigating
multiple sites around the same water body (e.g., separate habitat areas that respond differently to
the same fluctuations in stage).

These features are particularly helpful when using data from large gage networks, watershed-
scale hydrologic datasets, or output from substantial river hydraulics or reservoir system
simulation models, but should always be used with caution. Each feature is capable of adding
(or removing via “Batch delete... ’) many flow regimes, which can be difficult to undo. New
flow regimes can also be associated with groups as described in the next section.

5.2.2 Managing with Groups

HEC-EFM is capable of simulating thousands of flow regimes and relationships, but as numbers
grow, it becomes increasingly difficult to use the main EFM interfaces to select and deselect the
particular combinations of flow regimes and relationships desired for simulation. One way to
manage applications with large numbers of flow regimes and relationships is to create “Groups”.
Groups are collections of flow regimes and relationships. Groups are defined separately for flow
regimes and relationships (Figure 61) and then can be selected and deselected for simulation via
menu options associated with the “Edit — Flow Regimes — Groups” and “Edit — Relationships —
Groups” menu options (Manage, Select, and Deselect options). Relationship groups tend to be
structured around ecological similarities. Flow regime groups tend to reflect a shared theme
(separate groups for reservoir reoperations and channel modifications) or are organized per
location-based flow regimes (tributary and mainstem diagnostic points, separately).

Groups Unselected relationships Selected relationships
Flow regimes and relationships can be organized (separately) as groups. Groups can -
be added. renamed. or deleted and are easily selected or deselected for analysis. Little minnow spawning Migratory waterfowl
Big bass winter habitat Swooping swallow
Add Benthic macroinvertebre Add Island nesting habitat
Fish populations, Processes, Bird dynamics e Wetland health ‘
Riparian tree recrutmery
Rename group... Riparian tree inundation =
Wetland health reverse il
Delete group... Mussel - Host fish intera
Recrutment of large wo
Relationships for each group
Group Selected Relationships Select <~ Remove All
Fish populations Little minnow spawning habitat, Big bass winter h relationships... < >
Processes Wetland health, Recruitment of large woody deb k ’
Bird dynamics i i

ok ) [ [ o

R

Figure 61. Creation of relationship groups (Fish populations, Processes, and Bird dynamics) and
selection of relationships for the Bird dynamics group.
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5.2.3 Managing Output

When the Write Computation Arrays relationship option is selected, HEC-EFM writes output for
the computational steps performed while analyzing that relationship for each active flow regime.
Many time series and paired data outputs records are generated. Management of these outputs
becomes challenging as numbers of relationships and flow regimes increase, even when using
HEC-EFM Plotter. To help, HEC-EFM enables users to select which types of output to write
and to choose whether to apply those settings (Figure 62). Deselecting undesired outputs
reduces the computer memory needed to store output files, reduces compute times, and makes
use of HEC-EFM Plotter faster because there are fewer data records to track and display. The
default is to write all output.

B Cswampoma X

Flow Regimes

Time series

Seasonal extracts

Computations (duration and rate of change)
Seasonal results

Relationships »

Combo Relationships )

Manage Geo Queries...

Plotting Position Type »

Unit System > Exceedance-based

Languages N Exceedance curves
Ranges

Select Arrays Format »

V| Statistical results
I Set Output Selections... [ I ¢

Apply Output Selections Other
Parse Output Ecovalues
Handle Missing Data Dates

Missing Data Identifiers... Summations

Recalculat Ctrl+R
ecaiculate r+ Apply Cancel

Figure 62. HEC-EFM enables users to select which outputs to write (Set OQutput
Selections...) and to choose whether to apply those settings (Apply Output Selections).

5.3 Format Options for Model Tables

HEC-EFM also offers formatting options for tables generated by the software that report model
results and parameters. Through the “File — Select Style Sheets — Results” menu, several pre-
packaged options are available for the main results table (Figure 63). Different formats can be
helpful when including tables in reports, copy-pasting statistical results to spreadsheets for
additional calculations, or when suppressing unnecessary outputs. Choice of style sheet is a
project setting, which means that the selected style sheet will be used until a different one is
chosen by the user. New style sheet selections can be applied via the “File — Refresh Results”
menu option - it is not necessary to Recalculate. Pre-packaged options are currently available
only for the Results table.
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Evaluated on: 06/04/2020 14:18

Style sheet = Standard, flow and stage

Summary
Natural Gaged
Relationship Conf. | Stage, ft Flow, cfs Chg. Stage, ft Flow, cfs
Little minnow spawning habitat * 4,275.2 1,226 Pos 4,275.7 1,703
Big bass winter habitat * 4,274.1 525| Pos 4,274.3 609
Benthic macroinvertebrate biodiversity|* 4,279.4 6,620 Neg 4,277.2 3,190
Wetland health * 4,274.3 636/ Pos 4,274.5 771
Riparian tree recruitment * 4,274.9 1,017| Pos 4,275.1 1,129
Riparian tree inundation = 4,273.7 373| Neg 4,274.3 609
Index
Values
Index Gaged
A- Al -4.7
B - Fish 27.4
No reverse lookup flow frequency data sets were analyzed.
Reverse Look-ups - Flow Duration
Natural Gaged
Relationship Conf. = %X, of time Chg. %X, of time
Wetland health reverse lookup * 34.1| Pos 67.1

Evaluated on: 06/04/2020 14:18

Style sheet = Basic, flow only, inverted

Summary
Little mir_mow Blg. bass B_enthlc Wetland | Riparian tree | Riparian tree
spawning winter |macroinvertebrate health recruitment | inundation
habitat habitat biodiversity
Flow Regime | Flow, cfs | Flow, cfs Flow, cfs Flow, cfs Flow, cfs Flow, cfs
Natural 1,226 525 6,620 636 1,017 373
Gaged 1,703 609 3,190 771 1,129 609
File
Index Values :
Index/A - AllB - Fish New Ctr+N
Gaged| -4.7 274 Open... Ctrl+0
Save Ctrl+S
No reverse lookup flow frequency data sets were analyzed.
Save As...
Results
Reverse Look-ups - Flow
N Report
Duration ne
Wetland health ata Summary
reverse lookup Refresh Results
Flow Regime %X, of time
Natural 34.1 View Array File...
Gaged 67.1 Select Style Sheets Results » I ’7| Standard, flow and stage
Print Preview Report 4 Standard, flow only
Print Ctrl+P Data Summary » Standard, stage only
Arrays >
Recent Projects Y’ Standard, ecovalue
Exit Style Sheet Editor... Basic, flow and stage
! Basic, flow only

Basic, stage only
Basic, ecovalue

Basic, summations only

Basic, flow only, inverted

Basic, stage only, inverted
Basic, ecovalue, inverted

Basic, summations only inverted

Add Custom Style Sheet...
Remove Custom Style Sheet...

]

Figure 63. Choices of style sheets are made via the “File — Select Style Sheets” menu. The default
Results table format is controlled by a style sheet called “Standard, flow and stage”, as shown at the
top of this figure. The “Basic, flow only, inverted” format is also shown.
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Users are also able to add and remove custom style sheets for Results, Report, Data Summary,
and Arrays tables. Modifying style sheets is best done through XML editors. Several editors are
available online. An open source editor called XML Notepad is included with EFM and can be
opened via the “File — Select Style Sheets — Style Sheet Editor...” menu option. Custom style
sheets are used most often to modify numerical precision of output or appearance of tables. For
the Results table, settings for numerical precision are located towards the beginning of the style
sheets and can be modified by the user to adjust precision for each output variable, independently
(Figure 64).

New Ctrl+N -
Open..  Ctrl+O File Edit View Inset Window Help Update Available
Save Ctrl+$ DEHEH9™~ @A X P § @ = |C:\Programs(x86)\HEC\HEC~EFM\5.0\slats-standard.xsl VI
Save As...

Tree View XSL Output
Resups 0 xml version="1.0" encoding="utf-8" )
Report

B3 xsl:stylesheet
& xmlns:xsl
& version
#--IJ) xsl:output
#---CJ) xsl:variable

Data Summary http://www.w3.0rg/1999/XSL/Transform

Refresh Results 1.0

View Array File...

Select Style Sheets  »

Results

Print Preview

Print Ctrl+P

Report
Data Summary

& #comment
& #comment
& #comment
L) xsl:variable

HEC-EFM supports two types of number separators,..
Output differ amongst style sheets, but may include:..
Declare language and number format variables

v v v v

Arrays .
Recent Projects » e &) xsl:variable
) xsl:variable
) xsl:variable

+
+
Bt Style Sheet Editor... [ +
+
& #comment

+---{J) xsl:variable

Number formats

=G Xs1: iable
© hene]
[£] #text $
= xsl:value-of
& select $group_separator
) #text £33
= xsl:value-of
& select $decimal_separator
] #text 000
- Xsl:variable %
‘ name numformatstage
] #text ¥
=3 xsl:value-of
& select $group_separator
] #text $54
TFile | Summary
New Ctl+N Natural . ‘ Gaged
Oy Ctlio Relationship | Conf. Stage, ft | Flow, cfs _ Chg. | Stage, ft | Flow, cfs _
S Cois Little minnow spawning habitat * 4,275.2 1,226 Pos 4,275.7 1,703
ave rn+ T T T 1
Save A Big bass winter habitat ,* | 4,274.1_ 525_ Pos 4,274.3v 609_
Ve S Benthic macroinvertebrate biodiversity = _ 4,279.4| 6,620 g 4,277.2| 3,190/
Results Wetland health | . 4,274.3 636 Fos 4,274.5| 771
Report Riparian tree recruitment A" [ 4,274.97 1,017» Pos 4,275.1» 1,129_
Data Summary Riparian tree inundation * 4,273.7| 373| Neg 4,274.3| 609
View Array File... ) | Natural | ) Gaged
Select Style Sheets  » Relationship Conf. _ Stage, ft _ Flow, cfs ‘ Chg. Stage, ft ' Flow, cfs
Little minnow spawning habitat ‘* | 4,275.2‘ 1,225.721‘ Pos 4,275.7‘ 1,702.500
Rrnthreview Big bass winter habitat [* 4,274.1) 524.874 Fos 4,274.3 608.536
Print Ctrl+P Benthic macroinvertebrate biodiversity|* 4,279.4| 6,620.048  Neg 4,277.2| 3,190.000
Recent Projects » | Wetland health |* ‘ 4,274.3| 635.921 Pos 4,274.5 771.000
Exit Riparian tree recruitment * 4,274.9 1,017.322‘ Pos 4,275.1 1,128.990
Riparian tree inundation * | 4,273.7 372.853| Neg 4,274.3» 609‘000

Figure 64. The EFM style sheet editor is used to customize the format of EFM generated tables.
Image shows an increase in reported precision (from zero to three decimal places) for flow results.

5-6



HEC-EFM Quick Start Guide

Chapter 5 - Applying HEC-EFM

5.4

Using 2-Dimensional Information

HEC-EFM can import time series data that are stored in the Hierarchical Data Format (HDF) for
use as flow regimes. HDF is a frequently used database format (http://www.hdfgroup.org/) and
is employed by at least two HEC software to store model simulation outputs (HEC-RAS for two-
dimensional unsteady flow output and HEC-EFMSim for two-dimensional ecological simulation
output). Through the “Edit — Flow Regimes — Batch add from HDF ... ” menu option, users
specify input HDF files, dates and times of data being imported, data tables and key aspects of
their structure and content, and a naming convention for the flow regime. Resulting flow
regimes are compound in the sense that a single flow regime identifier contains multiple sets of
concurrent time series (or time series and paired data). For example, the first flow regime in
Figure 65, entitled “Wetland Restoration Zone”, has data that would comprise 2,940 traditional

HEC-EFM flow regimes and is one of the four listed that together have more than 32,000 parts.
Each part is computed independently for all active relationships. Users should consider style

sheet choice and output settings before applying HEC-EFM for large compound flow regimes.

BollingRiver_2DAhdf

o~ ) Event Conditions
o~ 4 Geometry
o~ ) Plan Data
¢ @ Results
o~ ) Summary
¢ @ Unsteady
o~ ) Geometry Info
¢ @ Output
¢ @ Output Blocks
¢ @ Base Output
o~ ) Summary Output
¢ @ Unsteady Time Series
¢ @ 2D Flow Areas
¢ @ Wetland

Depth

R Depth Max
ace Velocity
§h Node Vel Max

Nater Surface Max
Nater Surface Min
o CJ) Upland
o ) Aquatic
o ) Invasive
o~ 4 Cross Sections
o~ € Lateral Structures
o~ ) SA 2D Area Conn

o~ ) Storage Areas

o~ €4 DSS Hydrograph Output
o~ €4 DSS Profile Output
o~ 4 Summary

o~ ) Boundary Cofiditior|

q I [T»

i Depth at /Results/Unsteady/Output/Output Blocks/Base Output/Unsteady Time Series/2D ... o EI
if
This feature automates creation of flow regimes. It works only with time series data archived in
I ‘ HDF. Please use with caution. It can involve large datasets that are time consuming to compute.
| PFow regimes input file(s)
13 [RolingRiver_2D hdf [ [ Time link multiple HDF file | (¥]
0 9.551289  |13.2 Transitions: Skip | first v time steps
1 9.319008  |13. 4 EI
73 9.067829 12.7 Dates and times (of data to be imported)
B 8.8305435 [12.9 (O Specify start and end (@ Use table in HDF
4 8.682766 123 From 10/01/2016 0100 Time Date Stamp | | ...HDF
5 8803322 [124 . Lo I o
3 0257245 |12d T° 09/30/2019 2300 [] Start on columnirow 0
7 9.927292  [13.§ Interval | 1 hour [] End on column/row
8 10.511089 (142
9 10.671037 [14. Time series table(s)
10 10.581149 [14.2 Use one variable for both flow regime parts v
11 10.366725 [14.0
12 10101781 (137 p'stTeble[Depth | [L.HDF|  2ndTable
13 39 Dete Data
9.573799 13.9 -
15 9285209 |12 Time series values
16 9.015756 12.7 @® Columns @ Useall (2940) Usedaily Mean v
17 8.81242 12.9 . 0
18 8.758003  [124 OFRows O Selection ©
19 8.896116 12.4 . ; o
20 9126137 (124 © L] Sxtoncchmmiowr’ 10
21 0280885 |12d (@ Pericdaverage  [] Missing value screening
22 9.287884 12.9 Tove rocine nach
23 9196529 |12 e _ o
24 9.020717 124 |dentifier IWetland Restoration Zone I [ Limit arrays to:
25 8833112 [124 Prefix (optional) | | Picker | (0)
26 8.620605 123 Suffix (®) HDF label QO Integer 1
27 8.405911  [12.1 ‘
28 8.245533  [11.9 Setperiod of record (optional)
29 8294171 [11.9 Starting [J 6/ 4/2020 @~ |  Ending [ 6/ 42020 T |
30 8.703701 12
31 9.43162 13.1 Activate added flow regmes (optional)
32 10.23724 13.9 [4] Make "Active”
33 10.710088 (144
34 10.692303 [14.3
35 10.499058 [14.1 Aoply
36 10.224713 [13.9corvo rrorrocvvo 1geeCior vrouy CeowroTre T T
Flow regimes (paired time series of flow and stage)
Ref | Active Identfier 4~ | Fiename | PartA PartB PartF Starting
O| @ |wet ne RollingRiver_2D.hdf et 40) 0
O RollingRiver_2D.hdf U 02
O RollingRiver_2D.hdf A 02
O I ppression | RollingRiver_2D.hdf I 02/0
— d o BB Mt B i — B i e B ) otk e e
4 | [893121  [12.626957 [12.458491 [8.656705 [3.8730342 [0.0111412.. 4 |
a7 | B
<[ [»

Figure 65. Importing HDF data for use in HEC-EFM. Structure and content of an HEC-RAS 2D
output file is at back, “Batch add from HDF...” interface to right, and Flow regimes list at bottom.
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The data and mathematical process HEC-EFM uses to analyze compound flow regimes is the
same as for traditional flow regimes with one exception. Use of time series from HDF are
supported for a wide range of time steps (19 increments ranging from 1 minute to 1 day) whereas
only daily time series may be used in traditional flow regimes. During conversion from subdaily
to daily, users may specify which daily time series is of interest: means, minimums, or
maximums. HEC-EFM also provides a setting for the user to declare whether data from HDF
are instantaneous or period average values, which affects the conversion to daily values. Apart
from dealing with subdaily time steps, the process is unchanged. Data for each flow regime are
queried per the season, duration, rate of change, and percent exceedance parameters for each
relationship. Results are written and reported per output settings controlled by the user. Flow
regime names are recorded as “Identifier-suffix” for compound flow regimes.

As with traditional flow regimes, subsequent recalculations simply repeat the whole process.
Subdaily data are converted to daily, queried per relationship parameters, and then results are
written and reported. To save time, HEC-EFM offers a menu option “Preprocess from HDF
file...” that converts subdaily data to daily and saves the daily results in a new HDF table (Figure
66). An associated time/date table is also generated. The number of time series is unchanged;
all time series are processed. The resulting HDF file can then be used via the Batch Add Flow
Regimes from HDF interface as in Figure 65. Preprocessing has been shown to reduce overall
compute times by approximately one third.

I Flow Regimes % | Add... This feature converts data from a sub daily to 2 daily time step for use in EFM. Input and output are stored
Relationships > Rename:: in HDF. The daily data file produced is then available for use via the Batch add from HDF interface.
Combo Relationships » Reorder... Flow regimes input file(s)

S RollingRiver_2D hdf Time link multiple HDF files | [¥
Manage Geo Queries... Duplicate... l M )
Delete... Transitions: Skip | first v time step(s)
Plotting Position Type » B
. Import... Dates and times (of data to be imported)
Unit System > ) )
T R Open DSS Catalog... O Specify start and end (® Use table in HDF
= B From (06/03/2020 Time Date Stamp | | ...HDF
Select Arrays Format N Deselect reference timeseries -
. To [] Start on columnirow
Set Output Selections... Select all
Apply Output Selections Deselect all Interval |1 day [J End on columnirow
Parse Output Time series values
Manage groups... )
Handle Missing Data @® Columns @ Instantaneous Usedaily | Mean v
Select group... E
Missing Data Identifiers... O Rows O Period average
Deselect group...
Recalculate Ctrl+R Batch add... [[] Missing value screening
Batch add one for many... Time series table(s)
Batch delete.. Variable Input table Count Output table name A
Batch add from HDF file... 1 Depth 2940 Wetland_depth_daily
Preprocess from HDF file... E 2 Depth 2400 Upland_depth_daily
Reol n 3 20380 Aquatic_depth_daily
eplace pars.. 4 e 6371 Invasive_depth_daily
Replace input files... = v
Batch Recalculate... HDF output file
Name lRoIhngRuve(_ZD _preprocessed ]

Destination (folder) [Ro]]ing River J

BN

Figure 66. Avoid repetitive and time consuming conversions from subdaily to daily time steps via
the Preprocess Data from HDF feature. With this, subdaily data are converted and written as daily
values to a new HDF file that can then be used as input for flow regimes in HEC-EFM.
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5.5 HEC-EFM for Design

HEC-EFM offers an option to cycle computations, replacing one piece of flow regime input in
each iteration. This option is useful when designing hydrographs or designing topography — that
is, considering many hydrograph options with a single topography (reservoir reoperations) or
considering many topographic options for a single flow hydrograph (earthwork).

Cyclic application of HEC-EFM is initiated through the “File — Flow Regimes — Batch
Recalculate... ” menu option (Figure 67). Users specify which flow regime part to cycle through,
input data files and records, and output location and naming conventions. A master switch for
exporting results to DSS is provided here because this feature has the potential to generate much
output. The switch is a checkbox option labeled Compute arrays (export to DSS).

I Flow Regimes > I Add...
Rel e ) This feature allows users to cycle computations, replacing one piece of flow regime input in each iteration. It works
elationships g Rename... only with data archived in HEC Data Storage System (HEC-DSS). Please use this interface to specify which data
- i . > will be replaced and to identify the replacements. Output will be stored separately for each iteration.
Combo Relationships ; Reorder...
Manage Geo Queries... Duplicate... Specify the data to be replaced
. = Delete... (@ First record O Second record
Plotting Position Type >
§ Import...
Unit System » Replace data per
Languages » Open DSS Catalog.. (® Selection from DSSfile:  |Rolling River - Design Hydrographs.dss
Select Arrays Format » Deselect reference timeseries @ Cycle through: |C v | FLOW v| 50
Set Output Selections... Select all O Select data: 0
Apply Output Selections Deselect all
Parse Output OTable 31 #
Manage groups... — —— —— — =
Handle Missing Data Select group...
Missing Data Identifiers... Deselect group..
Recalculate Ctrl+R Batch add...
Batch add one for many...
Batch delete... Output E
Destination: |Roling River .| Subfolder: [Candidates ompute arrays
Batch add from HOF file... 9 (Conddstes | M fexporttoD59)
) Name
Preprocess from HDF file...
O DSS Pathname Part: A
Replace parts...
Replace input files... O DSS Pathname Parts: A - A
Batch Recalculate... S @ Prefix | DesignHydrograph| - Suffix (integer) E
O Prefix - DSS Pathname Part: A
O Prefix - DSS Pathname Parts: |A - A

Output name preview: DesignHydrograph-1.xml

[0 ) [ oy | [ s

Figure 67. The “Batch Recalculate...” option in HEC-EFM allows users to cycle computations by
replacing data associated with active flow regimes.

All other output controls (e.g., output settings and write computation arrays) remain in effect.
Several options are provided for flow regime output names as combinations of pathname parts
and user-defined prefixes and suffixes.

Again, it is important to note that only one data part of the flow regime is changed with each
iteration. An early application of this feature involved testing several hydrographs to determine
which generated the most ecological benefits. Flow regimes comprised of a flow time series and
a local rating curve were added for locations along the river and made active. HEC-EFM was
then used to test the set of hydrographs, each hydrograph being tested independently for all
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active flow regimes (locations). Output were written to tables and to HEC-DSS for subsequent
analyses. Figure 67 shows a scenario in which 50 hydrographs (C = FLOW) will be tested.
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CHAPTER 6

Multivariate Analyses

Habitat is often characterized by more than one variable. For example, per section 4.1.1, little
minnow need shallow water for spawning (no deeper than 3 ft), which is an expression of habitat
suitability based on a single variable, depth. If little minnow also needed water moving at more
than 0.5 ft per second, ideally between 1 and 2 ft per second, and no more than 3 ft per second
for spawning, then habitat suitability would be based on two variables, depth and velocity.
Habitat suitabilities are typically expressed as a number from 0 (wholly unsuitable) to 1
(perfectly suitable).

In HEC-EFM, “multivariate analyses” numerically combine suitabilities for different variables
into a single measure of suitability, which is useful for habitat mapping and when tallying habitat
provided. In EFM, multivariate analyses are applied only for compound flow regimes (2-
dimensional input).

Computations for multivariate analyses are done last during an EFM run because input to
multivariate analyses are generated while computing results for individual flow regime-
relationship pairings. Involving more than one flow regime-relationship pairing makes
multivariate analyses quite different than other EFM analyses, which are almost always done
independently for each flow regime-relationship pairing.

Using 2-dimensional data and multiple pairings can make multivariate analyses complex. This
chapter details creation of multivariate analyses and related numerical options, validations to
ensure viable analyses, and output.

6.1 Creating Multivariate Analyses

Multivariate analyses are set up via the HEC-EFM Relationships Tab. Technically, this means
that a multivariate analysis is part of its host relationship, but since input data are obtained from
multiple flow regime-relationship pairings, none of which need to be previously associated with
the host, choice of host relationship is important only because it sets season and partially sets
output name for the multivariate analysis.

Multivariate analyses are done as an option associated with ecovalue summations (Figure 68).
Clicking the settings button opens an interface that allows users to select the numeric method and
flow regime-relationship pairings for the multivariate analyses (Figure 69). Choice of flow
regime is important because it sets period of record and partially sets output name for the
multivariate analysis (output names are based on host flow regime and host relationship).
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Clicking Select pairings... opens an interface that allows users Ecovalue summation:
to select the pairings relevant for the multivariate analysis
(Figure 70). Pairings are offered for each combination of
(compound) flow regime and relationship (i.e., flow regime || o : :
relationship). The host relationship is appended with “**” to Multivariate analysis h‘

| Last computed time seres e |

For compound flow regimes

acknowledge this association though use of pairings with the (] Apply paired data t=blEs
host relationship is not required. The host flow regime is Output total for whole flow regime
listed in the first column. There can be only one multivariate Reportparts: () yes @ no

analysis per host flow regime and host relationship.
Figure 68. Multivariate analyses
are created via the Ecovalue
summation feature.

Numeric method: |F‘mdud to the nth root Vl

Variable Picker
Associate other vanables by selecting the desired flow regime -relationship pairings.

Flow Regime Selected pairings Select pain’ngﬁg
|Wetland Restoration Zone Wetland Restoration Zone || Depth Relationship™*, Wetand Restoration Zone || Velodty Relationship

Upland Management Area
Aguatic Structures

Invasive Species Suppression

ok ][ o | [ Coon |

Figure 69. Multivariate analysis entitled “Wetland Restoration Area || Depth Relationship”. Four
multivariate analyses could be created for the host “Depth Relationship”, one for each flow regime.

Unselected pairings Selected pairings

Upland Management Area Il Depth Relationship ‘wetland Restoration Zone (2940) || Depth Relationship™
Upland Management Area Il Velocity Relationship ‘wietland Restoration Zone (2340) || Velocity Relationship
Aguatic Structures | Depth Relationship

Aquatic Structures || Velocity Relationship Add >

Invasive Species Suppression | Depth Relationship
Invasive Species Suppression | Velocty Relationship
<- Remove

Add Al —=

- Remove All

o] o | [ Gmod

Figure 70. The Select Pairings interface allows users to pick which pairings to use in the
multivariate analysis.
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6.2 Numeric Methods

There are four options for numeric method: Product to the nth root, product, mean, and minimum
(Figure 71). Please note that multivariate analyses in HEC-EFM and the associated numeric
methods are intended to work with ecovalue time series based on suitabilities between 0 and 1.

Product to the nth root W
Product to the nth root

Product k
Mean

Minimum

Figure 71. Numeric methods for multivariate analyses.
For each time step:

Product to the nth root combines ecovalues by multiplying the ecovalues of each selected
pairing and then taking the nth root of that product.

Product combines ecovalues by multiplying the ecovalues of each selected pairing.

Mean combines ecovalues by summing the ecovalues of each selected pairing and then
dividing that sum by the number of selected pairings.

Minimum combines ecovalues by selecting the minimum ecovalue of all selected pairings.

6.3 Validations

Several validations are done to help users create and manage viable multivariate analyses. There
are a total of nine. All are applied at run time. The first seven are also applied as multivariate
analyses are created. When an invalid combination is detected, HEC-EFM identifies the failed
validation parenthetically at the end of the corresponding message.

1 - Current relationship has relationship-defined water year selected (all relationships invalid)

2 - Pairing relationship has relationship-defined water year selected (pairing relationship invalid)
3 - Flow regime inactive

4 - Relationship inactive

5 - Not an ecovalue summation relationship

6 - Mismatch in number of parts

7 - Season of pairing relationship not wholly nested in current relationship

8 - Temporal mismatch

9 - One or more ecovalue time series for selected pairings has values less than 0 or greater than 1

The first and second validations flag use of relationships that are incompatible with multivariate
analyses. The third and fourth check whether requisite inputs will be available for multivariate
analyses. The fifth checks whether relationships in selected pairings are ecovalue summation
relationships. The sixth checks whether the flow regimes in selected pairings have the same
number of parts. The seventh checks whether relationships in selected pairings have compatible
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seasons. The eighth checks whether the periods of record for selected pairings allow for
computation of multivariate analyses. The ninth checks whether ecovalue time series for
selected pairings have values less than 0 or greater than 1.

Failed validations for the first seven checks are reported via the Multivariate Analyses - Select
Pairings interface and at run time. For example, Figure 72 shows a selected pairing that failed
validation 6 - Mismatch in number of parts. The number of parts for the Aquatic Structures flow
regime (20,380) is different than the number of parts for the Wetland Restoration Zone flow
regime (2,940). Validation 6 checks that the number of parts for selected pairings are equal,
which is a simple check intended to flag spatial discrepancies. Invalid selections can be saved,
allowing users to continue working with their EFM projects, but will fail at run time.

Unselected pairings Selected pairings

Wetland Restoration Zone Il Velocity Relationship wetland Restoration Zone (25340) || Depth Relationship™
Upland Management Area ll Depth Relationship Aquatic Structures (20380) || Velocity Relationship (6)
Upland Management Area | Velocity Relationship

Aquatic Structures | Depth Relationship Add >

Invasive Species Suppression | Depth Relationship
Invasive Species Suppression |l Velocity Relationship
<- Remove

Add Al —

<— Remove All

Figure 72. Failed validations are reported in the Select Pairings interface. Red text is used to
highlight problems and includes the failed validation identifier (in this image, “6”).

The eighth and ninth validations are only done at run time because the periods of record and
ecovalues needed for validation are generated during the compute process. As multivariate
analyses are done last, this approach does leave the possibility that a run will fail unexpectedly
late in its compute cycle. Messages about run time validation fails (for all validations) are
provided in EFM output tables and via pop-up windows that can be left open as a reference for
users troubleshooting multivariate analyses (Figure 73).
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Multivaniate analy=es require common spatial and temporal extents and are

Ecovalue Summations - incompatible with some EFM options. One or more multivariate analyses failed
. . validations. Flease review problem codes and selections to assure
Multivariate consistency for the following mulirvanate analyses:
Depth . —
Relationship Wetland Restoration Zone | Depth Relationship (&)

Flow Regime Ecovalue, total
Wetland Restoration Zone Invalid (&)

Evaluated on: 6/26/2024 1:50:22 PM

Figure 73. Validations failed at run time are reported in EFM output tables (left) and warning
message windows (right).

6.4 Output

During compute, ecovalue time series for each selected pairing are combined based on the
numeric method chosen by the user. Combined ecovalue time series are then tallied in the same
progression (see section 3.6.3) as done for other ecovalue summations: 1) daily combined
ecovalue series, 2) tally for flow regime, 3) tally status at the end of each season, 4) tally total
for flow regime, 5) tally for each season, 6) tally total for each season, and 7) a ranked set of
seasonal totals from #6.

There is an Apply paired data option (Figure 68, see section 6.1) that allows the combined
ecovalue series to be multiplied by a paired data set prior to tallying. For multivariate analyses,
paired data associated with the host flow regime are applied via this option. The most common
application of paired data in multivariate analyses is to multiply the combined ecovalue time
series (in terms of suitabilities) by area per flow regime part (paired data) to compute time series
of suitable habitat (in terms of area).

Results of multivariate analyses are stored in HDF and DSS and reported in HEC-EFM results
tables. All DSS outputs for multivariate analyses are labeled with a c-part that includes
“multivariate”.

Two style sheets (see section 5.3) are provided for rendering output tables of multivariate results,
“Basic, multivariate only” and “Basic, multivariate only inverted”, the latter of which has flow
regimes in rows and relationships in columns and is recommended when rendering multivariate
results for numerous flow regimes or flow regime parts.

Figure 74 provides an overview of the compute process and DSS outputs, which are then
available for viewing in HEC-EFM Plotter.
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EFM compute process

Flow Regimes (4):  Wetland Restoration Zone
Upland Management Area

Aquatic Structures
Invasive Species Suppression

For the 8 flow regime - relationship pairings:
Apply statistical queries and ecovalues to
compute seasonal and statistical results

l

Selected Pairings (2 of 8)
Wetland Restoration Zone || Depth Relationship: Wetland Restoration Zone || Depth Relationship
Wetland Restoration Zone || Velocity Relationship

\/

Relationships (2): Depth Relationship
Velocity Relationship

Multivariate Analysis

Obtain ecovalue time series for each selected pairing: e

/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Part - Wetland Restoration Zone-Depth Relationship/
/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Part - Wetland Restoration Zone-Velocity Relationship/

Combine ecovalue time series per numeric method (computations done for each time step):
/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Parts/

Option to Apply Paired Data done, if instructed by user: 0
/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Series/

Tally based on E - Parts or E - Series, if paired data applied: e

/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Tally/

/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Tally results/

/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Tally seasonal/

/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Tally seasonal results/
/Wetland Restoration Zone/Depth Relationship/Multivariate//1day/E - Total/

/Wetland Restoration Zone/Depth Relationship/Multivariate//{time range}/EX - Tally seasonal results/

@ Standard Plots L3 200

i q
Flow Regime [ Active only @ 180+ l
Wetland Restoration Zone v 160
Relationship [ Active only
Depth Relationship < Wy
(O Custom Plots W . 120+
4]
& = 100
3
Refresh g 80
g 60
View results for: Multivariate o 2 404
Use metric units: 20 4‘_l_4_'_l_'J
DSS Selector 0 U Il i U U U
26 3 10 17 24 31
Apr2009 May2009 |
Language ¥ English (HEC) [< >]
Y wy Al +
(] /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAY/E - PART - WETLAND RESTORATION ZONE-DEPTH RELATIONSHIP/
/WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAY/E - PART - WETLAND RESTORATION ZONE-VELOCITY RELATIONSHIP/ 188.0
/WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAY/E - PARTS/ 187.5
/] —— /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAY JE - SERIES/ 187.0
/WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAY/E - TALLY/ 18651
O  /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAY/E - TALLY RESULTS/ 3 : )
%] /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIPMULTIVARIATE//1DAY/E - TALLY SEASONAL/ S 186.07
B /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE// 1DAY/E - TALLY SEASONAL RESULTS/ & 185.5
[F] ® /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/MULTIVARIATE//1DAYE - TOTAL/ .= 185.0
= 184.57
; z x 184.01—— T T T U
—a— /WETLAND RESTORATION ZONE/DEPTH RELATIONSHIP/FREQ-MULTIVARIATE/2009-2009//EX - TALLY SEASONAL RESULTS/ 0999909909 05 04001 0.0001
Exceedance Probability (freq)

Figure 74. Compute process and DSS outputs related to multivariate analyses.
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CHAPTER 7

Language Support

Since HEC-EFM was first publicly released, several suggestions have been offered regarding
how particular features might be better labeled and documented to make them more intuitive.
While this is a wonderfully simple and constructive idea, creating one ideal set of terms and
descriptions is challenging because different teams have different preferences and lexicons. To
empower study teams to make HEC-EFM as useful as possible, several features have been added
that allow the software to be customized, including output format options, style sheet options,
custom style sheets, set output selections, and style sheet editor. In HEC-EFM 5.0 and HEC-
EFM Plotter 3.0, the software was further modified to allow users to specify interface labels. For
individual users, this enables interface text to be changed to whatever is deemed most
communicative. For international users, this enables translation of interface text.

7.1 Languages

In HEC-EFM, “languages” are comprised of: 1) name, 2) language file, 3) Quick Start Guide, 4)
Demonstration Project, and 5) Language for system labels. Name is assigned by the user to
identify the language. Language file is a text file that contains all interface labels. Quick Start
Guide and Demonstration Project are file and pathname pointers to customized or translated
versions of HEC-EFM user guidance and demonstration projects. Both are optional. If
unspecified, HEC-EFM will continue to use the default files associated with those resources that
are provided as part of the HEC-EFM install. Language for system labels offers users a choice
of language and dialect, which is then used by HEC-EFM to determine format of numeric output
in results tables. HEC-EFM 5.0 has a default language named “English (HEC)” that uses labels
from a version-specific default language file entitled “EFMLanguage HEC.txt”.

In HEC-EFM Plotter, languages are comprised of: 1) name and 2) language file. The other
HEC-EFM language components are not relevant because Plotter guidance and demonstrations
are included as part of the corresponding HEC-EFM materials and Plotter only uses number
formats associated with the English (United States) language and dialect. HEC-EFM Plotter 3.0
has a default language named “English (HEC)” that uses labels from a version-specific default
language file entitled “EFMPIlotterLanguage HEC.txt” (Figure 75).

Languages may be associated with the software or with particular applications. “Program
languages” are languages associated with specific versions of the software. After one or more
program languages are specified, new instances of the software will open with the most recently
used program language and all program languages will be in the language list. “Project
languages” are languages associated directly with an application. When the application is
opened, its project language will be used, regardless of any subsequent changes to program
languages. Project languages only appear in the language list of the associated project.
Supporting both language types allows users to use the software with multiple languages on a
single computer and have existing applications use different languages than used in new projects.
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HEC-EFM Quick Start Guide

File Edit Format View Help

00000=0K A
00001=Cancel

00002=App1ly

00003=Select time series record file

00004=Dss files

00005=Text files

00006=DAT files

00007=Csv files

00008=PRN files

00009=HDF files

00010=The selected flow regimes input file called
00011=does not exist

00012=Use edit menu to rename

00013=New

00014=Ref

00015=Active

00016=Identifier

00017=Filename

00018=Part A

00019=Part B

00020=Part C

00021=Part E

00022=Part F

00023=Starting

00024=Ending v

File Edit Format View Help
00000=0K Al
00001=Cancel

00002=Yes

00003=No

00004=Error

00005=warning

00006=Style

00007=Label

00008=Flow Regimes:
00009=Relationships:
00010=X-AX1is

00011=Y-AXis

00012=to

00013=Mark individual years
00014=Year Range:
00015=Individual year(s) (yyyy):
00016=Fill In

00017=Fil11 out

00018=Update Existing

00019=Add Custom Plot
00020=Custom Plots

00021=wY

00022=View results for\:
00023=Fil1l In

00024=Fi11 out v

Figure 75. Language files for HEC-EFM (left) and HEC-EFM Plotter (right). Language files
contain label integers and the corresponding label text.

7.2 Creating and Managing Languages

Languages can be added, updated, and removed.

New languages will appear alphabetically in

the languages list below the default language “English (HEC)”. Language names must be

unique.

Selecting the “Add Language...” menu option opens an interface where the parts and type of
language are specified (Figure 76a, HEC-EFM; Figure 76b, HEC-EFM Plotter). Changing the

language parts or type of an existing language is done through the “Update Language...’

’

interface. Obsolete languages may be deleted via the “Remove Language...” interface. The
Associate with program check box determines whether the language is a program (check box
selected) or project (check box unselected) language.

Several validations are done to check whether languages are ready for use. Validations are
performed when new instances of the software are initiated, when a language is added, when a
language is updated, and when the language file associated with the active language is saved.
When any of these events occur, a two-part validation is performed. First, the software checks
whether files associated with the language are available. If the language file is not available,
validation fails, a warning message is delivered, and the language is added as an invalid language
(gray and unselectable). If the language file is available, the language advances to the second
part of the validation (in HEC-EFM, advancement occurs even when files associated with the
Quick Start Guide or Demonstration Project are not available - installed copies of those files are
used in lieu of missing language specific files). The second part of validation compares the list
of label integers in the language file to the corresponding list in the default language file. If all
labels are present, validation is successful and the language is added to the language list (black
and selectable). If one or more labels are missing, validation fails, a warning message is
delivered, and the language is added as an invalid language.
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Edit
Flow Regimes 4
Relationships y
Combo Relationships 3

a

Manage Geo Queries...

Unit System > = [Spa = ]
ame: ni

Languages > l English (HEC)

Language file: |Spanish for EFM 5.0.txt || =
Select Arrays Format > l Add Language...
Set Output Selections... Update Language... Quick Starc Gulde (optosal) lE:M Sula de Inicio Repkdo-pdf ]
Apply Output Selections Remove Language... Demonstration Project (optional): [Rjo Rolling.exe }
Parse Output Edt Lasiguage Files Language for system labels: Spanish (Mexico) v
Handle Missing Data Associate with program Cancel
Missing Data Identifiers... R

Recalculate Ctrl+R

Language | W _English (HEC)
~  English (HEC)

Add Language... Name: Spanish

Update Language... Language file:  Spanish for EFM Plotter 3.0.txt

Remove Language...

Assodate with program @ Cancel
Edit Language Files...

Figure 76. Adding a language involves specifying language parts, including name and language file.
Image shows Spanish being added as a program language to HEC-EFM (a) and HEC-EFM Plotter

(b).

Language file editors are accessible in HEC-EFM and HEC-EFM Plotter via the “Edit Language
Files...” menu options. These editors allow users to open, create, and close language files. The
“Allow Editing” menu option controls whether open language files can be edited (Figure 77a,
HEC-EFM,; Figure 77b, HEC-EFM Plotter). Editors initial open with only the default language
shown. Additional language files can then be opened, viewed and edited via the “Open
Language File...” and “New Language File...” right click menu options. Changes made to the
language file of the active language are shown in software interfaces when that language file is
saved via the editors.

Users are not required to use the editors in HEC-EFM and HEC-EFM Plotter. Language files are
simple text files that are compatible with many different software. Customized labels or
translations can be made in web translators, word processors, spreadsheets, and other software.
New labels can be saved directly to language files or pasted into HEC-EFM and HEC-EFM
Plotter editors and then saved.

The language list includes program and project languages, whether valid or invalid (Figure 78).
Users may switch between valid languages whenever desired. Invalid languages must be fixed
via the “Update Language...” menu option before use.
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[ Display default
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Figure 77. Language file editors in HEC-EFM (a) and HEC-EFM Plotter (b) are used to open,
create new, close, edit, and save language files.
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Figure 78. Language list and language selection in HEC-EFM. Image shows HEC-EFM
demonstration project with Korean as the active language.

7.3 Compatibility with New Software Versions

HEC-EFM 5.0 and HEC-EFM Plotter 3.0 are the first versions of those software to allow
customization and translation of user interfaces. As those software continue to advance,
language files will change to accommodate revisions and new labels. In this sense, language
files are version specific even though most labels will not change from version to version.

HEC-EFM and HEC-EFM Plotter store language information per version. This helps maintain
compatibility with already built language resources because existing projects and software will
open with the proper language resources.
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To assist with forward compatibility, release notes for future versions will include a list of
language integers that were added or altered. Also, language file editors add new language
integers when an existing language file is opened and then saved as a new file (doing a file Save
would work too, but doing a file Save as... would also maintain integrity of the original file,
which is potentially a language resource for other existing projects). New interface labels are
displayed with the corresponding integer values as placeholders pending inclusion of customized
or translated labels.

Disconnects in languages can be caused by changing computers or relocating, renaming, or
deleting files associated with languages. Repairing languages is straightforward as long as the
language resources are still available.

Please note that HEC-EFM and HEC-EFM Plotter have been developed exclusively on
computers that use English (United States) as the active windows language. International users
have encountered problems with performance on computers that use other languages as the
active windows language. It would be very difficult to thoroughly test the software for a wide
selection of active windows languages.

International users are encouraged to apply HEC-EFM and HEC-EFM Plotter on
computers with English (United States) as the active windows language. The language
support features detailed in this chapter will allow software interface labels to be translated to the
user’s language of choice to assist with application.

7.4 Opportunities and Resources

HEC develops a wide range of software related to water resources, many of which work together
and share databases in order to function. Language support, in terms of the coding needed to
enable customization or translation of interfaces, is not consistent amongst HEC software. Also,
internal testing of HEC software is done almost entirely with English (United States) as the
language and dialect environment. Software like HEC-EFM and HEC-EFM Plotter, which offer
language support, may require additional code enhancements to remedy problems that arise
when applied in different language environments. This is the nature of software development.
As a software expands, imperfections need to be resolved to achieve design performance.

With language support, knowledge of different languages is also a fundamental challenge. The
developers of HEC-EFM and HEC-EFM Plotter invite partnerships to help translate these
software, supporting documentation, and demonstration projects from English to other
languages. These partnerships do not provide participating organizations with any exclusive
advantages, whether competitive, financial, or other. No funds or source code will be
exchanged. HEC will support these efforts by providing already publicly available text
documents and assistance with questions pertaining to the translations. Partnering organizations
perform translations and provide translated documents back to HEC for free distribution via the
web, with no constraints.

This offer recognizes that user communities for these software are global and that a simple way
to promote good water and ecosystem management practices in other parts of the world is to
provide technologies in native languages, free of cost.
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CHAPTER8

Conclusions

This quick start guide is designed to demonstrate the process used to apply HEC-EFM and to
highlight some features of the software. Everything covered in this document and all features
active in the software have been tested extensively, but there is still the potential for undetected
problems to surface. If a bug or suspect behavior is noted, please refer to HEC’s website
(www.hec.usace.army.mil/software/HEC-EFM/BugReporting/) for guidance on bug reporting.

To summarize, HEC-EFM is designed to help study teams determine ecosystem responses to
changes in the flow regime of a river or connected wetland. HEC-EFM analyses involve: 1)
statistical analyses of relationships between hydrology and ecology, 2) hydraulic modeling, and
3) use of GIS. Through this process, study teams define existing ecologic conditions, highlight
promising restoration sites, and assess alternatives according to predicted ecosystem changes.

The spatial products of this process are commonly managed and analyzed with a tool called
HEC-GeoEFM. Development of HEC-GeoEFM is a partnered effort between HEC and
Environmental Systems Research Institute, Inc. (ESRI). Version 1.0 was released in June 2011.
It contains a suite of features (habitat calculators, patch tools, etc.) that help modelers perform
the spatial computations typically used in HEC-EFM applications.

HEC-EFM has many strengths, most notably it 1) is capable of testing change for many
ecological relationships and management scenarios, 2) links ecology with established hydrologic,
hydraulic, and GIS tools, and 3) can be applied quickly, inexpensively, and can incorporate
expert knowledge. HEC-EFM is a generic software tool in the sense that it is applicable to a
wide range of riverine and wetland ecosystems, water management concerns, and restoration
projects.

HEC-EFM also has key limitations, including: 1) uses only daily data, 2) no explicit tracking of
inter-year dynamics, and 3) outputs are often proxies or indicators for more tangible ecological
attributes such as species population levels and ecosystem services.

New features are being added to HEC-EFM, HEC-EFM Plotter, and HEC-GeoEFM that advance
their collective ability to analyze flow regimes and to map and assess habitats. Additionally,
long-term development will enable HEC-EFM to simulate ecosystems in time and space and to
animate results. This spatial and temporal linking promises to address the limitations noted
above and is being implemented in parallel to the software's current capabilities.

This scalability, where applications of these software can be statistical analyses of flow regimes
or also map habitat or simulate population dynamics, allows modeling to be customized per the
needs of different projects and offers opportunities to engage study teams and stakeholders by
producing results at each level of application.
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HEC-EFM and HEC-GeoEFM are certified for national use by Headquarters of the U.S. Army
Corps of Engineers as recommended by the Corps’ Ecosystem Center of Expertise. Model
certification is a corporate determination that a model is a technically, theoretically, and
functionally sound and can be applied during the Corps planning process for purposes consistent
with the model’s design and limitations. HEC-EFM has many possible applications. The most
common are ecosystem restoration planning, water management decision-making, benefit and
impact analyses related to water levels, and natural resources management considerations.
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CHAPTER9

Terms and Conditions for Use

Use of the program is governed by the terms and conditions for use. They limit what can be done with
the program software, waive warranty, limit liability, and indemnify the developers and the United States
government. The program cannot be used unless the terms and conditions for use are accepted; the full
text is given below.

Terms and Conditions for Use

The United States Government, US Army Corps of Engineers, Hydrologic Engineering Center ("HEC")
grants to the user the rights to install Ecosystem Functions Model (HEC-EFM) "the Software" (either
from a disk copy obtained from HEC, a distributor or another user or by downloading it from a network)
and to use, copy and/or distribute copies of the Software to other users, subject to the following Terms
and Conditions for Use:

All copies of the Software received or reproduced by or for user pursuant to the authority of this Terms
and Conditions for Use will be and remain the property of HEC.

User may reproduce and distribute the Software provided that the recipient agrees to the Terms and
Conditions for Use noted herein.

HEC is solely responsible for the content of the Software. The Software may not be modified, abridged,
decompiled, disassembled, un-obfuscated or reverse engineered. The user is solely responsible for the
content, interactions, and effects of any and all amendments, if present, whether they be extension
modules, language resource bundles, scripts or any other amendment.

The name "HEC-EFM" must not be used to endorse or promote products derived from the Software.
Products derived from the Software may not be called "HEC-EFM" nor may any part of the "HEC-EFM"
name appear within the name of derived products.

No part of this Terms and Conditions for Use may be modified, deleted or obliterated from the Software.

No part of the Software may be exported or re-exported in contravention of U.S. export laws or
regulations.

Waiver of Warranty

THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS, REPRESENTATIVES,
AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS PROVIDE HEC-EFM
\"AS IS,\" WITHOUT ANY WARRANTY OR CONDITION, EXPRESS, IMPLIED OR STATUTORY,
AND SPECIFICALLY DISCLAIM ANY IMPLIED WARRANTIES OF TITLE,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT.
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Depending on state law, the foregoing disclaimer may not apply to you, and you may also have other
legal rights that vary from state to state.

Limitation of Liability

IN NO EVENT SHALL THE UNITED STATES GOVERNMENT AND ITS AGENCIES, OFFICIALS,
REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND SUPPLIERS,
BE LIABLE FOR LOST PROFITS OR ANY SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF OR IN CONNECTION WITH USE OF HEC-EFM REGARDLESS OF
CAUSE, INCLUDING NEGLIGENCE.

THE UNITED STATES GOVERNMENT’S LIABILITY, AND THE LIABILITY OF ITS AGENCIES,
OFFICIALS, REPRESENTATIVES, AND EMPLOYEES, INCLUDING ITS CONTRACTORS AND
SUPPLIERS, TO YOU OR ANY THIRD PARTIES IN ANY CIRCUMSTANCE IS LIMITED TO THE
REPLACEMENT OF CERTIFIED COPIES OF HEC-EFM WITH IDENTIFIED ERRORS
CORRECTED. Depending on state law, the above limitation or exclusion may not apply to you.

Indemnity

As a voluntary user of HEC-EFM you agree to indemnify and hold the United States Government, and its
agencies, officials, representatives, and employees, including its contractors and suppliers, harmless from
any claim or demand, including reasonable attorneys' fees, made by any third party due to or arising out

of your use of HEC-EFM or breach of this Agreement or your violation of any law or the rights of a third

party.

Assent

By using this program you voluntarily accept these terms and conditions. If you do not agree to these
terms and conditions, uninstall the program and return any program materials to HEC (If you downloaded
the program and do not have disk media, please delete all copies, and cease using the program.)
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